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 دوربین های تحت شبکه

یکاربر یراهنما   

1.00: آموزش  نسخه   
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 .دیریدرخواست، لطفا با فروشنده تماس بگ ایدر صورت هر گونه سوال  میمحصول ما متشکر دیخر یاز شما برا

  حق چاپ

 چیبه ه ایتواند در هر صورت و  یدفترچه راهنما نم نیاز ا یبخش چیمحفوظ است. ه این مطالب برای شرکت فوژان اکسوم تمام حقوق

  .شود عیتوز ایترجمه و  ر،یتکث ،یاز شرکت ما کپ یقبل تیوجه بدون رضا

یاعتبار علامت تجار دییتأ  

Exsom یشرکت ها و نام ها ینام ها ،یعلائم تجار ریسا ،فوژان بوده شرکت یو آرم ها متعلق به فن آور اکسوم یتجار یعلامت ها گریو د 

 .باشد یکتاب متعلق به صاحبان مربوطه م نیا محصول موجود در

 تیسلب مسئول

 
 حساب، لطفا پسورد اول خود را تیاز امن نانیاطم یشود. برا یورود شما استفاده م نیاول یفرض برا شیرمز عبور پ

.دیکن می)حداقل هشت کاراکتر( تنظ یرمز عبور قو کیشود  یم هی. توصدیده رییتغ 

 

  

عامل و اسناد خود، بر  ستمیشده با سخت افزار، نرم افزار، س فیانون قابل اجرا، محصول توصمجاز توسط ق به حداکثر حدبا توجه  ⚫

 .ارائه شده است "به عنوان"اساس 

 نیتضم دیکتابچه نبا نیدر ا هیتوص ایاطلاعات و  ه،یانیب چیراهنما است، اما ه نیا اتیصحت و صحت محتو دییتأ یتلاش برا نیبهتر ⚫

 اتیداشت. محتو مینخواه یتیدفترچه مسئول نیدر ا یپیتا ای یفن یهر گونه خطا یباشد. ما برا یضمن ایشده  انیه بهر گون یرسم

 کتابچه اضافه خواهد شد. نیا دیبه نسخه جد یکند. بروز رسان یم رییتغ یبلکتابچه بدون اطلاع ق نیا

هر گونه  یصورت ما برا چیکاربر خواهد بود. در ه تیر عهده مسئولآن به طور کامل ب جهیکاربر و نت یکتابچه راهنما نیاستفاده از ا ⚫

از دست  ایاز دست دادن سود کسب و کار، وقفه کسب و کار،  یاز جمله، خسارت برا م،یرمستقیغ ای یتصادف ،یخسارت خاص، منف

 . بود میشما قابل اعتماد نخواه یمحصول، برا نیمربوط به استفاده از ا اسناد ایرفتن اطلاعات 

محصول  نیشود. قبل از استفاده از ا میکه از کشور به کشور متفاوت است، تنظ ینیتواند توسط قوان یم یو صوت یرینظارت تصو ⚫

دستگاه را  یرقانونیغ اتیاز عمل یهر گونه عواقب ناش تی. ما مسئولدیکن یخود را بررس یاهداف نظارت، قانون در منطقه محل یابر

 .رفتیپذ مینخواه

کتابچه  نیموجود در ا ریمدل متفاوت باشد. تصاو ایمرجع است و ممکن است بسته به نسخه  یکتاب فقط برا نیار د ریتصاو ⚫

از نمونه ها و  یبرخ جه،ینت کیشده باشد. به عنوان  یکاربر سفارش ماتیخاص و تنظ یازهایکاربر ممکن است مطابق با ن یراهنما

  داده شده متفاوت باشد. شینما روتیمان درتوابع برجسته ممکن است با آنچه که 

 نشده است. یطراح یهر محصول خاص یبرا نیچند محصول است و بنابرا یمدل ها یکتاب راهنما برا نیا ⚫

کتابچه وجود  نیمرجع ارائه شده در ا ریو مقاد یواقع ریمقاد نیممکن است اختلاف ب ،یکیزیف طیمانند مح نانیبا توجه به عدم اطم ⚫

  در شرکت ما وجود دارد. ریتفس ییاداشته باشد. حق نه

  
   ! هشدار



 

 ج‌
 

 ستیز طیحفاظت از مح 

و  نیمحصول، قوان نیمناسب، استفاده و دفع ا یساز رهیذخ یشده است. برا یطراح ستیز طیالزامات حفاظت از مح تیرعا یمحصول برا نیا

 .ردیمورد توجه قرار گ دیبا یمقررات مل

 نمادها

 طیتا از شرا دینشان داده شده را دنبال کن یشوند. به دقت دستورالعمل ها افتیهنما چه رادفتر نیممکن است در ا رینمادها در جدول ز

 .دیو از محصول درست استفاده کن دیکن یریخطرناک جلوگ

 

  نماد  شرح

 بیتواند باعث آس یدهد که م یرا نشان م یطیمهم است و شرا یمنیا یدستورالعمل ها یحاو

 رساندن به بدن شود.
  هشدار!   

سوء عملکرد محصول  ای بینادرست ممکن است موجب آس اتیو عمل دی، مراقب باشگرامی خواننده

 شود.

 

  احتیاط!   

 توجه!    .مکمل در مورد استفاده از محصول است ای یدیاطلاعات مف یبه معنا
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 اتصال شبکه    1

با کابل  میشبکه را به طور مستق نیدورب دیبا وتر،یکامپ کیاز   IPC )ای IP Camera به نام نیهمچن( شبکه نیدورب کیبه  یقبل از دسترس

 .دیروتر وصل کن ای چیسوئ قیاز طر ایشبکه 

 

 
 IPC PC   

 .دیاستفاده کن وتریو کامپ تحت شبکه نیدورب ی واسط شبکهبین اتصال  یرا برا (STP) شبکه بلکا

 

 
 IPC Switch or Router PC   

 .دیاستفاده کن سوییچ یا روترو  تحت شبکه نیدورب ی واسط شبکهبین اتصال  یرا برا (STP) شبکهکابل 

 ورود    2

 یآماده ساز
 دیتوان یم ن،یدورب روشن شدن. پس از دیروشن شدن آن به برق وصل کن یرا برا نیدورب د،یانجام داد عیسر یا راهنمانصب را مطابق ب نکهیبعد از ا

 نترنتی. ادیکن دایپ ینصب شده است، دسترس GuardStation  دهنده سینرم افزار سرو ایمرورگر وب  کیکه با  یشخص انهیرا کیرا از  نیدورب

 GuardStation کاربر ی، به راهنما GuardStation در مورد شتریکسب اطلاعات ب یشده است. برا هیتوص مرورگر وب کی (IE) راکسپلور

 .دیمراجعه کن

 .بررسی میکنیمبه عنوان مثال  7 ندوزیو کروسافتیعامل ما ستمیس کیرا در  IE کی ریزدر 

 بررسی شودقبل از ورود  ⚫

 کند. یدرست کار م نیدورب ⚫

 . است صحیح نیو دورب وتریکامپ نیاتصال شبکه ب ⚫

⚫ PC بالاتر نصب شده است. ای 10.0اکسپلورر  نترنتیبا ا  

 .شده است میتنظ x 1440 900( رزولوشن به یاری)اخت ⚫

 

 

 

 

 

 

 

 

 شبکهکابل 
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 .دیمعتبر اضافه کن تیسا کیرا به عنوان  IP آدرس
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.کرد رییاگر تغ دیکن نیگزیخود جا نیدورب یفرض است. لطفا آن را با آدرس واقع شیپ IP مثال آدرس نیدر ا IP: 192.168.1.13 آدرس

 کاربر یکنترل دسترس ماتیتنظ ریی( تغیاری)اخت

 Never notify  به  User Account Control Settings ، دیکن میمراحل را تنظ ن،یبه دورب یقبل از دسترس

 

 ورود به رابط وب
 .است 255.255.255.0فرض  شیپ رشبکهیاست و ماسک ز 192.168.1.13 نیفرض دورب شیپ کیاستات یپ یآدرس آ

 DHCP سرور کیفرض فعال است. اگر  شیبه طور پ DHCP در شبکه استفاده شود، آدرس IP شود و شما  یم نییتع ایشما به صورت پو نیدورب

 .دیه کناستفاد GuardStation خود از نیدورب ایپو IP مشاهده آدرس ی. برادیورود استفاده کن یدرست برا IP از آدرس دیبا

 .پردازد یم یروش ورود فیتوص یاکسپلورر به عنوان مثال برا نترنتیا با ریزدر 

 .دیخود در نوار آدرس، به صفحه ورود وارد شو نیدورب حیصح IPبا وارد کردن آدرس  .1

  

مرورگر خود را  دینصب با لیمتک ی. برادیرا نصب کن ActiveXو  دیکن را دنبال ستمیس فعالیت های د،یشو ستمیبار وارد س نیاول یاگر برا .2

 .دیببند

  
 .دیرا فشار ده Enterو  دیکن پیرا در نوار آدرس تا ActiveX ، http: // IP address / ActiveX / Setup.exe نصب دستی یبرا .1

رمز عبور  کیشود  یم هی. توصدیده رییغحساب، لطفا پسورد اول خود را ت تیاز امن نانیاطم یشود. برا یورود شما استفاده م نیاول یفرض برا شیرمز عبور پ .2

 .دیکن میاراکتر( تنظ)حداقل هشت ک یقو

 یشش بار به طور متوال باکند. اگر ورود  یناموفق محافظت م ستمیورود به س یمحدود کردن تعداد تلاشها قیاز طر یقانون ریغ یخود را از دسترس ،نیدورب .3

 .شود یار قفل مر خودکبه طو قهیبه مدت ده دق نینتواند انجام شود، دورب

 

 توجه!       
  

  

1 

2 
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 توجه!       
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و کلمه عبور  "admin" فرض پیش کاربری نام از ورود، اولین برای. کنید کلیک ورود روی سپس و کنید وارد را عبور رمز و کاربری نام .3

 استفاده کنید. "123456"

می شود. در غیر این صورت، باید پنجره وارد سیستم شوید، هنگام ورود به سیستم، ویدیو زنده نمایش داده  Live Viewاگر شما با انتخاب  •

Live View کنید. فعاله صورت دستی را ب 

. برای اطمینان از امنیت، نداریدشوید می رمز ورود هر بار که وارد سیستم  به وارد کردن، نیازی هنگام ورود ذخیره پسورد را انتخاب کنیداگر  •

 توصیه نمی شود که ذخیره رمز عبور را انتخاب کنید.

 کلیک کنید. Reset، روی Save Passwordنام کاربری و رمز عبور و گزینه  حافظهکردن  پاک برای •

 مقدمه ای بر رابط وب

 .مثال زیر نشان می دهددر نمایش داده می شود.  به طور پیش فرض پنجره نمایش زنده زمانی که شما به رابط وب وارد شوید

 

  شماره  شرح

 1  منو

 PTZ منطقه کنترل

 .در دسترس است PTZ و دوربین های PTZ این منطقه برای دوربین های گنبدی :باشید داشتهتوجه 

2 

 3 پنچره نمایش زنده

 4  نوار ابزار نمایش زنده

 پیکربندی اولیه
 .پس از ورود به دستگاه، لطفا تنظیمات اولیه زیر را انجام دهید

  مورد  شرح 

 اترنت.1 تنظیم کنید. مجددا س شبکه واقعیو پارامترهای شبکه را بر اسا IPتنظیمات  

دوباره با استفاده از آدرس  خروج از سیستم و. 2 - 

IP .جدید به وب وارد شوید 
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  مورد  شرح 

 کنید. نظیمترا  ساعت سیستم .3 زمان سیستم را براساس وضعیت واقعی تنظیم کنید. 

 اساس شبکه واقعی تنظیم کنید.سرور مدیریت را بر  
 ی( سرور مدیریت را تنظیم کنید.تیار)اخ .4

)اختیاری( سرور را برای ذخیره عکس ها . 5  سرور را برای ذخیره عکس بر اساس شبکه واقعی تنظیم کنید. 

 .تنظیم کنید

 .را تنظیم کنید OSD. 6 ، مانند زمان، تنظیم کنید.است اطلاعاتی را که بر روی صفحه نمایش مورد نیاز 

 
اربران معمولی را در صورت نیاز اضافه ا تغییر دهید و کگذرواژه پیشفرض ر

 کنید.

 .)اختیاری( مدیریت کاربران .7

  

 تنظیم کنید. نیازا توجه به زنده را تماشا کنید. لطفا پارامترهای دیگر را ب تصاویرپس از اتمام پیکربندی اولیه، می توانید 

  
ممکن است با مدلها متفاوت باشد.  مقادیرو محدوده  های نمایش داده شدهداده شده، پارامتر نشان نمایش زنده کاربریرابط  •

 لطفا جزئیات رابط کاربری واقعی وب را ببینید.

 .پارامترهایی که خاکستری هستند را نمی توان تغییر داد. برای تنظیمات واقعی، رابط وب را ببینید •

 عبور، رمز تغییر نحوه مورد در بیشتر جزئیات برای. دهید رییتغ را خود عبور رمز بار اولین در ورود هنگام شود می توصیه •

 .کنید مراجعه امنیت بخش به

 

  

 پارامترها‌پیکربندی    3

 پارامترهای محلی
.رتان تنظیم کنیدبرای کامپیوت را پارامترهای محلی

 

  

 Setup > Common > Local Settingsمراحل زیر را طی کنید : .1

  

  

  
 .ببینیدبا مدلها متفاوت باشد. لطفا جزئیات رابط کاربری واقعی وب را پارامترهای محلی ممکن است 

  

 توجه!     

 توجه!     
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 جدول زیر برخی پارامترهای مهم را شرح می دهد.، ر دهید صورت نیاز تغییتنظیمات را در ‌.2

  شرح  پارامترها

Intelligent  
Mark  

Untriggered 

Target  

هنگامی که فعال می شود، دوربین یک علامت روی صفحه در هدف نشان می دهد )به عنوان مثال 

 .آن را دنبال می کندفعال است( و  تشخیص چهرههنگامی که 

Video  
Processing Mode  

Real-Time Priorityاست توصیه می شود ی: اگر شبکه در وضعیت خوب. 

Fluency Priority  : داشته باشیدزنده  نمایشکوتاهی را برای  تاخیر خواهید زماناگر شما می 

 .توصیه می شود

Ultra-low Latency  یه می هید توصمی خوا نمایش زندهبرای  یزمانتاخیر : اگر شما حداقل

 .شود

Protocol   می شودبه وسیله کامپیوتر رمزگشایی  که را تصویریپروتکل مورد استفاده برای انتقال جریان. 

Record 

and 

Snapshot  

Recording  

⚫  : Subsection By Time مدت زمان ضبط ویدئو برای هر فایل ضبط بر روی کامپیوتر. به عنوان

 .دقیقه 2مثال، 

⚫  : Subsection By Size هر فایل ضبط ذخیره شده بر روی کامپیوتر. به عنوان  سایز حجمی

 مگابایت5   مثال، 

Record  
Overwrite  

⚫ Overwrite : تکمیل هنگامی که فضای ذخیره سازی اختصاص داده شده در رایانه مورد استفاده

 .ط فایل ایجاد شود، دوربین فایلی ضبط شده را حذف می کند تا فضای جدیدی برای ضبمیگردد

⚫ Full Stop :به  هنگامی که فضای ذخیره سازی اختصاص داده شده در رایانه پر شده است، ضبط

 .طور خودکار متوقف می شود

  

 .کلیک کنید Save  گزینه روی .بر3
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 تنظیمات شبکه

 اترنت

.دستگاه ها ارتباط برقرار کنددوربین را تغییر دهید تا دوربین بتواند با سایر  IP تنظیمات ارتباطی مانند آدرس

 
 برای ورود به سیستم استفاده کنید. IP، باید از آدرس جدید IPپس از تغییر آدرس  •

 .سرور هنگامی که دستگاه با نام دامنه قابل دسترسی است قابل اجرا است DNS (Domain Name System) تنظیمات  •

 

  

 آدرس استاتیک

  Setup > Network > Network مراحل زیر را طی کنید : .1

   

  .کنید انتخاب Obtain IP Address لیست از را Static گزینه.2

 .دوربین در شبکه منحصر به فرد است IP ، ماسک زیر شبکه و آدرس دروازه پیش فرض را وارد کنید. اطمینان حاصل کنید که آدرسIP آدرس.3

 کلیک کنید.  Saveبر روی گزینه .4

PPPoE  

 

  

 .انتخاب کنید IP به عنوان حالت دستیابیرا  PPPoE ، شما باید(PPPoE) اترنت متصل استبر بستر نقطه به نقطه  طریق از ن به شبکهاگر دوربی

  Setup > Network > Network مراحل زیر را طی کنید :.1

  
   

  
   

 .پشتیبانی نمی شود. لطفا مدل واقعی را برای جزئیات ببینید این عملکرد توسط بعضی از مدل ها
   

 توجه!     

 توجه!     
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 . انتخاب کنید Obtain IP Address لیست از را PPPoE  گزینه.2

 ( را وارد کنید.ISPده سرویس اینترنت شما )رائه شده توسط ارائه دهننام کاربری و رمز عبور ا.3

 کلیک کنید.  Saveبر روی گزینه .4

DHCP  
در شبکه  DHCP سرور کی. اگر فعال است شود یداده م لیتحو نیکه دورب یفرض هنگام شیبه طور پ (DHCP) ایپو زبانیم یکربندیپروتکل پ

 . کند افتیدر DHCP را از سرور IP آدرس کیار طور خودک تواند به یم نی، دوربشده باشدمستقر 

 :دیرا دنبال کن ریمراحل ز ، DHCP تنظیم دستی یبرا

1. Setup > Network > Network.  

  

 کلیک کنید.  Saveبر روی گزینه ، انتخاب کنید Obtain IP Address لیست از را DHCP  گزینه .2

IPv6  

  .Setup > Network > Network مراحل زیر را دنبال کنید : .1
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 .شده است میتنظ Manual به IPv6 فرض حالت شیبه طور پ .2

.در شبکه منحصر به فرد باشد دیبا IP . آدرسدیکن میفرض را تنظ شیو دروازه پ شوندیطول پ د،یرا وارد کن IPv6 آدرس.    3

 

 کلیک کنید.  Saveبر روی گزینه 

 .به آن متصل شوندرا جستجو و  Wi-Fi یتوانند شبکه ها یاز دستگاه ها م یبرخ

 .  Wi-Fi Mode برای Wi-Fi انتخاب.  Setup > Network > Network انتخاب .1

  

وجود ی  گرید Wi-Fi یدهد که شبکه ها ی. صفحه نشان مکنیدروشن را  Adaptive Streams . شود یداده م شینما گنالیقدرت س .2

 .دیکن کیکل Search ی، رو Wi-Fi یدوباره شبکه های جستجو یدارد. برا

کلیک   Saveبر روی گزینه  .شود یداده م شی. اطلاعات مربوط به شبکه مربوطه نمادیکن کیکل Wi-Fi شبکه ستیدر ل SSID کی یرو .3

 کنید.

 کلیک کنید.  Saveبر روی گزینه    . 4  

 Wi-Fi   

  
 .دینیبب اتیجزئ یرا برا یشود، لطفا مدل واقع ینم یبانیاز مدل ها پشت یبرخدر عملکرد  نیا   

  
 کلیک کنید Wi-Fiو روی گزینه   Setup > Network > Networkرا دنبال کنید :مراحل زیر .1              

 

  

  
 Sniffer . ا انتخاب کنیدر  

   

 توجه!     
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 یبه دستگاه ها Wi-Fi تواند به عنوان نقطه نقطه اتصال یم نیشود، دورب یم میتنظ Wi-Fi Hotspot به Wi-Fi که حالت یهنگام .4

 .عمل کند گرید

  

 کلیک کنید.  Saveبر روی گزینه  .5

Port  

 

 .  Setup > Network > Port : مراحل زیر را دنبال کنید .1

  

 شماره های مربوط به پورت را تنظیم کنید .2

 کلیک کنید.  Saveبر روی گزینه  .3

FTP  

 یبود عکس ها دی، شما قادر خواهFTP مید از تنظشود. بع یم رهیذخ یعموم FTP سیسرو قیچهره( از طر صی)به جز تشخ یفور یتمام عکس ها

 .دیارسال کن یمشخص FTP شبکه را به سرور یها نیاز دورب یفور

 عمومی

  .شوید General وارد تب Setup > Storage > FTP انتخاب .1

  
   

 .این عملکرد توسط بعضی از مدل ها پشتیبانی نمی شود. لطفا مدل واقعی را برای جزئیات ببینید
   

 توجه!     
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، Upload Images را تنظیم کنید.  FTP به سرور ریآپلود تصاو یو رمز عبور مورد استفاده برا ی، نام کاربرFTP سرور یو پورت برا IP آدرس.2

Overwrite Storage   و دیکن انتخابرا Overwrite At تستاز  نیدورب یاز مدل ها یمجددا(. برخ ریتصاو ی)آستانه برا دیکن میرا تنظ FTP 

 .دیکن شیرا آزما FTP دیتوان یم FTP ماتیکند. بعد از اتمام تنظ یم یبانیپشت

 صورترا به  ریمثال، مس ی. برادیکن میرا تنظ لیو فرمت نام فا FTPدر سرور  یفور یعکس ها رهیذخ مسیر. 3

 Preset No.\\IP Address\\Date\\Hour(s) صورترا به  لیکرده و نام فا میتنظ 

 Preset No.-PTZ Zoom-PTZ Latitude-PTZ Longitude.jpg.  دیکن میتنظ. 

 .دیکن کیکل رهیذخ ی. رو4

Smart  
  یهوشمند، رو FTPاستفاده از  یشود. برا یچهره استفاده م صیهوشمند مانند تشخ یعملکردها یبرا یفور یعکس ها رهیذخ یبرا عملکرد نیا

Setup> System> Server> Intelligent Server و نوع ارتباط  دیکن کیکلPlatform  را بهFTP دیکن میتنظ. 

  .بروید Smart تب به Setup > Storage > FTP انتخاب .1
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 .دیکن میرا تنظ FTP به سرور ریآپلود تصاو یو رمز عبور مورد استفاده برا ی، نام کاربرFTP و پورت سرور IP آدرس .2

 صورترا به  ریمثال، مس ی. برادیکن میرا تنظ لیو فرمت نام فا FTP در سرور یفور یعکس ها رهیذخ یبرا ریمس .3

 Preset No.\\IP Address\\Date صورترا به  لیکرده و نام فا میتنظ 

 Preset No.-PTZ Latitude-PTZ Longitude-PTZ Zoom.jpg دیکن میتنظ. 

 .دیکن کیکل Save یرو .4

E-Mail  

 .بود دیمشخص شده خواه لیمیبه آدرس ا امیشوند، شما قادر به ارسال پ یکه آلارم ها فعال م یزمان ل،یمیا میپس از تنظ

  .Setup > Network > E-mail  مراحل زیر را دنبال کنید .1
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می  رندهیآدرس گ میکند. بعد از تنظ یم یبانیپشت لیمیا آزمایشاز  نیدورب یاز مدل ها ی. برخرا تنظیم کنید رندهیمربوط به فرستنده و گ یپارامترها.2

 .دهد یمهم را شرح م یپارامترها یبرخ ری. جدول زدیرا امتحان کن لیمیا توانید

  شرح  پارامتر

TLS/SSL  

 هیلا ای TLS (Transport Layer Security) با استفاده از یخصوص میمحافظت از حر یبرا لیمی، اشودفعال  یوقت

 .خواهد شد یرمزگذار (SSL) سوکت امن

از  لیمیکند، ا یبانیپشت SSL از SMTP ارسال کند. اگر سرور SSL اتصال کی قیاز طر آن را کند یتلاش م ابتدا

  .ارسال کند STARTTLS کند با استفاده از یتلاش م نصورت،یا ریغشود؛ در  یارسال م SSL اتصال قیطر

Attach Image  
 .دهد یقرار م مهیرا به عنوان ضم یعکس فور 3ضبط،  یبا توجه به فاصله زمان لیمیشود، ا یکه فعال م یهنگام

Username/Password  
 .دهد یاجازه م & ٪ | <> '' /: *؟ \ ژهیو یها. رمز عبور تا کاراکترلیمیآدرس ابرای ثبت و رمز عبور  ینام کاربر

  

 .دیکن کیکل Save یرو.3

 آدرس دهی پورت

  .شوید Port Mapping تب وارد Setup > Network > Port انتخاب .1
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2 .Port Mapping اگر دیرا انتخاب کن آدرس دهیو نوع  دیرا فعال کن .Manual  دنشو یکربندیپ دیبا یخارج یانتخاب شده باشد، سپس پورت ها 

(IP دیآ یبه دست م نیبه طور خودکار توسط دورب یخارج)  اشغال شده باشد،  تنظیم شدهاگر پورتStatus  فعال خواهد شد ریغ. 

 .دیکن کیکل Save یرو.3

DNS  

  .Setup > Network > DNS  انجام دهید :مراحل زیر را  .1

  

 .دیکن میرا تنظ DNS آدرس سرور .2

 .دیکن کیکل Save یرو .3

DDNS   

 

  

  .Setup > Network > DDNS  مراحل زیر را انجام دهید : .1

  

2. DDNS Service .را فعال کنید 

  EZDDNS یا  ,DynDNS, NO-IP را انتخاب کنید DDNS  یکی از انواع .3

 .دیو رمز عبور کامل کن یرا از جمله آدرس سرور، نام دامنه، نام کاربر گرید ماتیتنظ .4

 .دیکن کیکل Save یرو .5

  
   

 .رد توسط بعضی از مدل ها پشتیبانی نمی شود. لطفا مدل واقعی را برای جزئیات ببینیداین عملک
   

 توجه!     
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P2P 

 
 .ستیتمام مدل ها در دسترس ن یبرا عملکرد نیا •

 (Android  ای  iOS) کنید با تلفن همراه خود اسکن را QR کدبرنامه  دانلود یبرا •

.دیمراجعه کنبه برنامه  قیدق یها ییراهنما ی. لطفا برادیاجرا کن نیاضافه کردن دورب یرا برا برنامهنصب،  پس از •

 

  

  .Setup > Network > P2P :  دهید مراحل زیر را انجام .1

  

 .دیرا انتخاب کن On ، سیفعال کردن سرو یبرا .2

 .دیکن کیکل Save یرو .3

802.1x  

802.1x  توانند یشده م دییتا یکند. فقط دستگاه ها یاتصال به شبکه فراهم م ی( در تلاش برانهای)به عنوان مثال دورب ییدستگاهها یصحت را برا دییتأ 

 .دهد یم شیرا افزا تیامن نیا .شوندشبکه متصل  به

 Setup > Network > 802.1x  مراحل زیر را انجام دهید : .1

  

2. On دیرا انجام ده گرید ماتیو سپس تنظ دیرا انتخاب کن. 

 .دیکن کیکل Save یرو .3

 

 

     
   

 توجه!     
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 پیکربندی تصویر

 تنظیم تصویر

 
 خود،  نیدورب مقادیرو  یواقع یپارامترها یمتفاوت باشد. برا نیمجاز ممکن است با مدل دورب مقادیرداده شده و  شینما ریتصو یپارامترها •

 .دیوارد کن جای خودرا در  ریمقاد میبه طور مستق ای دیکن میرا تنظ ماتیتا تنظ دیکن جابجارا  صفحات دیتوان ی. شما مدینیرابط وب را بب

 .اندباز میگردفرض  شیپرا به حالت  ریتصو ماتیتمام تنظ  Default یبر رو کیبا کل •

 

  

 صحنه میتنظ

 .مختلف یزنده در صحنه ها دئویو اثرات دلخواه بر اساس ریبه تصو یابیدست یبرا ریتصو یپارامترها میتنظ

  .Setup > Image > Image  انتخاب :

 .دیانتخاب کن ییکشو ستیصحنه دلخواه را در ل دیتوان یشود، م یداده م شینما ریاز مدل ها به صورت ز یبرخ یصحنه برا تیریصفحه مد

  

 .دیصحنه انجام ده یکربندیپ یرا برا ریمراحل ز دیتوان یشود، شما م یداده م شینما ریاز مدل ها به صورت ز یصحنه برخ تیریصفحه مد

  

  Scenes  انتخاب .1

 .دهد یم مهم را شرح یپارامترها یبرخ ری. جدول زدیکن میصحنه را تنظ متغییر ماتیو سپس تنظ دیصحنه را انتخاب کن کی .2

  شرح  ستون

Current  

 .دهد یشود را نشان م یکه استفاده م یصحنه ا

 توجه :

 .دیده شیصحنه نما یمربوطه را برا ریتصو یو پارامترها دیصحنه انتخاب کن رییتغ یرا برا optionدکمه  ⚫

 .دهد یم رییرا تغ یبه طور خودکار صحنه فعل نیشود، دورب یانتخاب م Enable Auto Switching که یهنگام ⚫

Scene Name  

صحنه را انتخاب  کیکه  یکند. هنگام یشده را فراهم م نییتع شیحالت صحنه از پ نیدستگاه چند نیا.  ینام صحنه فعل

 یواقع یازهایرا با توجه به ن ریتصو ماتیتنظ دیتوان یشوند. شما م یداده م شیمربوطه نما ریتصو یپارامترها د،یکن یم

 .دیکن میتنظ

     
 توجه!       
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 شرح ستون

 ⚫ Common : شود یم هیتوص باز یفضا یصحنه ها یبرا.  

⚫ Indoor : شود یم هیتوص یداخل یصحنه ها یبرا. 

⚫ High Sensitivity : شود یم هیکم نور توص طیمح یبرا. 

⚫ Highlight Compensation :اصلاحجلو در جاده ها و نورافکن در پارک ها را  یمانند چراغها یتواند نور قو یم 

 .شود یم هیگرفتن پلاک خودرو توص یشود برا یم هیکند. توص

⚫ WDR : که  گرید یصحنه ها ایو  یبا کنتراست بالا مانند پنجره، راهرو، درب ورود یبا نورپرداز ییصحنه ها یبرا

 .شود یم هیهستند توص درخشان ، اما کم نور در داخل

⚫ Customدیکن میتنظ ازینام صحنه را در صورت ن ک: ی 

⚫ Face : است دهیچیپ یدر صحنه ها ،کته در حرضبط چهر. 

Auto  
Switching  

 .دهد  ینشان م را خودکار رییصحنه به فهرست تغ کیاضافه کردن 

 توجه : 

به  ستمیشود، س یصحنه برآورده م رییتغ یبرا طیکه شرا یهنگام ستمیانتخاب شده باشد، س Auto Switchingاگر 

 .فرض است شیشامل صحنه پ ضیفرض فهرست خودکار تعو شیطور پ کند. به یم رییصحنه تغ کیطور خودکار به 

Setup  

 ی(بر رویو جهت افق PTZ نیب هیزاو) ی، نور، و ارتفاع فعلزمانی خودکار، از جمله برنامه رییتغ طیشرا میتنظ یبرا

شده  نییتع یماندر طول دوره ز ارتفاع فعلیو  ییروشنا یخودکار فقط وقت تغییراست که  یمعن نی. به ادیکن کیکل

 .نامعتبر است طی، شراباشدشده  میتنظ 0به  انیاع و پشرو ریشود. اگر مقاد یم میشود، تنظ یمطابقت داده م

 .دیکن میفرض تنظ شیعنوان صحنه پ به به وسیله و سپس آن را  دیصحنه را انتخاب کن کی.3

های به صورت خودکار به حالت  تواند یم نیفرض برآورده شود دورب شیپ ریصحنه غ ضیتعو یبرا طیکه شرا یدر صورت خودکار فعال باشد، تغییراگر . 4

باقی می  یدر صحنه فعل نیدورب ست،یخودکار فعال ن تغییرکه  یماند. هنگام یم یفرض باق شیدر صحنه پ نیصورت، دورب نیا ریکند. در غ تغییرصحنه 

 .ماند

خواهد کرد. اگر نه،  رییشده تغ میتنظ یصحنه ها نیدر دسترس نخواهد بود(، دستگاه ب یصحنه ا ماتیخودکار فعال باشد )تنظ تغییراگر 

 .فرض فعال شود شیپ ریغ یصحنه ها نکهیماند مگر ا یم یفرض باق شیپ یخواهد ماند. دستگاه در صحنه ها یباق یدستگاه در صحنه فعل

 .شود( یشروع م 5تا  1کند )از  یم رییتغ یناولویت عدد پایفرض فعال شود، دستگاه با  شیپ ریصحنه غ نیاگر چند

 

عکس تیفیک شیافزا

 

  

 کلیک کنید . Image Enhancement و سپس بر روی  Setup > Image > Image وارد  .1

  

 .دهد یمهم را شرح م یترهاپارام یبرخ ری. جدول زدیوارد کن مایرا مستق ریمقاد دیتوان یم نی. شما همچندیها استفاده کنمتغییراز  ماتیتنظ رییتغ یبرا.2

     
  

     
        

 توجه!     

 .دینیبب اتیجزئ یوب را برا یمدلها متفاوت باشد لطفا رابط واقع توجه به ممکن است با عملکرد نیا توجه!     
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  شرح  مورد

Brightness  

 .دیکن میرا تنظ ریتصاو ییدرجه روشنا

  

Low brightness  High brightness  

Saturation  

 را تنظیم کنید. مقدار گرمای رنگ تصاویر

  

Low saturation  High saturation  

Contrast  

 .دیکن میرا تنظ کسلیپ رینسفیدتو  کسلیپ نیاهتریس نیدرجه تفاوت ب

  

Low contrast  High contrast  

Sharpness  

 .را تنظیم کنید ریتصو کیدر  اءیاشبین مرز اختلاف 

  

Low sharpness  High sharpness  

2D Noise 
Reduction  شود ریتصو یعملکرد ممکن است منجر به تارشدگ نی. اریتصاو زیکاهش نو. 

3D Noise  

Reduction  
کاربردها ایجاد سایه یه اصطلاحا از  یدر بعض ایحرکت شود ) یعملکرد ممکن است سبب تار نی. اریتصاو زیکاهش نو

 .(شکل شبح

Image Rotation  ریچرخش تصو 
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 شرح  مورد

 

  

Normal  

 

 

  

Flip Vertical  

 

 

 Flip Horizontal 

 

                        180° 

 

 

90° Clockwise 

                       90° Anti-clockwise 

  

 .دیکن کیکل Default یمنطقه، رو نیفرض در ا شیپ ماتیبازگرداندن تنظ یبرا.3

Exposure  

  
 .دینیوب را بب یلطفا رابط واقع شتریاطلاعات ب یعملکرد ممکن است با مدلها متفاوت باشد. برا نیا •

 اصلاح لازم باشد نکهیمگر ا دیفرض استفاده کن شیپ ماتیاست. از تنظصحنه سازگار  با فرض شیپ ماتیتنظ •

 

  

 کلیک کنید. Exposure شوید و سپس روی گزینه Setup > Image > Image وارد .1

     
 توجه!       
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 .شود یداده م شینما ریصفحه به صورت ز ن،یدورب یاز مدل ها یبرخ یبرا

  

 .دهد یمهم را شرح م یپارامترها یبرخ ری. جدول زدیکن میتنظ ازیپارامترها را در صورت ن .2

  شرح  پارامتر

Exposure  

Mode  

 .دیمناسب را انتخاب کن یمورد نظر، حالت نورده یبه اثر نورده دنیرس یبرا

⚫ Automatic :کند یم میرا تنظ ینورده زانیم ، طیبه طور خودکار با توجه به مح نیدورب. 

⚫ Custom : کند یم میتنظ ازیرا در صورت ن ینورده ماتیکاربر تنظ. 

⚫ Indoor 50Hz  :کاهش خطوط با محدود کردن فرکانس شاتر. 

⚫ Indoor 60Hz  :کاهش خطوط با محدود کردن فرکانس شاتر. 

⚫ Manual :یدست ریو وضوح تصو شیشاتر، افزا میبا تنظ قیدق ریتصو تیفیک. 

⚫ Low Motion Blur: حرکتحین شده در گرفته  یحرکت در چهره ها یکاهش تار یشاتر برا نیکنترل کمتر. 

Shutter (s)  

است.  عیحرکت سر یصحنه ها یآل برا دهیا عیشود. سرعت شاتر سر یدر لنز استفاده م وارد شدهکنترل نور  یشاتر برا

 .کنند یم رییتغ یاست که به آرام ییصحنه ها یسرعت شاتر آهسته برا کی

 سرعت زانیم دیتوان یشود، م یم میتنظ Shutter Priority ای  Manualبه   Exposure Modeکه  یهنگام ⚫

  .دیکن میشاتر را تنظ

 .باشد میاز نرخ فر شتریب دیسرعت شاتر با شده باشد، متقابلا میخاموش تنظ  Slow Shutterاگر  ⚫

Gain (dB)  

 .می دهدنور طیبر اساس شرا یاستاندارد ییدئویو یها گنالیس یخروج نیکه دورب یبه طور یریتصو یها گنالیکنترل س

 Gain ای  Manualبه صورت   Exposure Modeکه  دیکن میتنظ یپارامتر را فقط زمان نیا دیتوان یشما م

Priority باشد تنظیم شده. 
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  شرح  پارامتر

Slow Shutter بخشد یکم نور بهبود م طیرا در شرا ریتصو ییروشنا. 

و  نشده میتنظ  Shutter Priorityبه  re ModeExposu که  دیکن میتنظ یپارامتر را تنها زمان نیا دیتوان یشما م

 .است  رفعالیغ  Image Stabilizerکه  یهنگام

 

Slowest 

Shutter  

 .کند میتواند تنظ یم نوردر هنگام قرار گرفتن در معرض  نیکه دورب یسرعت شاتر نیکمتر

 .استروشن   Slow Shutterکه  دیکن میتنظ یپارامتر را فقط زمان نیا دیتوان یشما م

Compensation  
 .دیکن میبه اثرات مورد نظر، مقدار جبران را تنظ دنیرس یبرا

 .باشد نشده میتنظ Manualبه صورت   Exposure Modeکه  دیکن میتنظ یپارامتر را فقط زمان نیا دیتوان یشما م

Metering 

Control  

 .دیکن میرا تنظ نیشدت نور دورب یرینحوه اندازه گ ⚫

⚫ Center-Weighted Average Metering : ریتصاو ینور به طور عمده در قسمت مرکز یریاندازه گ. 

⚫ Evaluative Metering :ریتصاو ینور در منطقه سفارش یریاندازه گ. 

⚫ Highlight compensation :میتنظ نی. اما انتخاب اریتصاو روشناز حد  شیقسمت ب ییگرفتن روشنا دهیناد 

 .دهد یرا کاهش م ریتصو یکل ییروشنا

⚫ Face Metering :حالت چهره گرفته شده در  ییبا کنترل روشنا فیضع نوری طیدر شرا ریتصو تیفیک میتنظ
 .صحنه چهره

 .باشد نشده میتنظ Manualبه صورت   Exposure Modeکه  دیکن میتنظ یپارامتر را فقط زمان نیا دیتوان یشما م

Day/Night  

Mode  

• Automatic : تواند به  یم نیحالت، دورب نیدهد. در ا یم شیمطلوب را نما رینور، تصاو طیشرابا توجه به  نیدورب

 .کند رییحالت شب و حالت روز تغ نیصورت خودکار ب

• Night : کند یبالا را با استفاده از نور موجود فراهم م تیفیبا ک دیو سف اهیس ریتصاو نیدورب 

• Day : کند یفراهم م اده از نور موجودبالا را با استف تیفیبا ک یرنگ ریتصاو نیدورب. 

Day/Night 

Sensitivity  

نور  ریینسبت به تغ نیاست که دورب یبالاتر بدان معن تیحالت روز و حالت شب. حساس نیب ضیتعو یآستانه نور برا

 .کرد چیحالت روز و حالت شبانه سوئ نیتوان ب یم یحساس تر است و به راحت

 .شود میتنظ  Automaticبه صورت   Day/Night Modeکه  دیکن میتنظ یط زمانپارامتر را فق نیا دیتوان یشما م

Day/Night 

Switching(s)  

 مدت زمانیکه دوربین قبل از تغییر حالت روز به حالت شب منتظر میماند و پس از گذشت این زمان تغییر وضعیت میدهد 

 .شود میتنظ  Automaticبه صورت   Day/Night Modeکه  دیکن میتنظ یپارامتر را فقط زمان نیا دیتوان یشما م

WDR  

WDR دیمشخص کن ریتصو کیرا در  کیروشن و تار یها نهیتا زم دیرا فعال کن. 

باشد و   Manualو نه   Customizeنه   Exposure Modeکه  دیکن میتنظ یپارامتر را تنها زمان نیا دیتوان یشما م

 .است رفعالیغ  Image Stabilizerکه  یهنگام

WDR Level  

 .دیبهبود ده WDR سطح میرا با تنظ ریتصو دیتوان ی، مWDR عملکرد یپس از فعال ساز

. در مورد کنتراست دیصحنه وجود دارد استفاده کن کیمناطق روشن و تار نیکه کنتراست بالا ب یبالاتر هنگام ای 7از سطح 

 .دیتفاده کناس 6-1از سطح  ای دیکن رفعالیرا غ WDR شود یم هیکم، توص

Suppress 

WDR  

Stripes  

کند تا  میتواند به طور خودکار فرکانس شاتر آهسته را با توجه به فرکانس نور تنظ یم نیشود، دورب یکه فعال م یهنگام

 .ظاهر شود، به حداقل برساند ریرا که ممکن است در تصاو ییموجها

 .دیکن کیکل Default یفرض، رو شیپ ماتیبازگرداندن تنظ یبرا.3
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چراغ هوشمند

 

 کلیک کنید. Smart Illumination شوید و سپس روی  Setup > Image > Image وارد  .1

  

 .دهد یمهم را شرح م یپارامترها یبرخ ری. جدول زدیکن میپارامترها را تنظرا انتخاب کرده و  IR کنترل ی ازدرست حالت .2

  شرح  پارامتر

Lighting Type  

⚫ Infrared :کند یاز نور مادون قرمز استفاده م نیدورب. 

⚫ White Light :کند یاستفاده م دیاز نور سف نیدورب. 

 1000تا  0تواند سطح نور را از  یم نیشود، دورب یم میتنظ Manualبه صورت   Control Modeکه  یهنگام

 .کند میتنظ

Control Mode  

⚫ Global Mode: نورمتعادل،  ریبه تصو یابیبه منظور دست نیدورب IR را انتخاب  نهیگز نیکند. اگر ا یم مینور را تنظ
 ریتصو ییاگر محدوده نظارت شده و روشنا نهیگز نیشوند. ا روشناز حد  شیاز مناطق ب یممکن است بعض د،یکن

 .شود یم هیتوص اول شما باشد تیاولو

⚫ Overexposure Restrain :میتنظ یاز حد منطقه ا شیبر نواز بروز  یریجلوگ یرا برا یو نورده ییروشنا نیدورب 

 یاگر وضوح قسمت مرکز نهیگز نی. ادیرا انتخاب کن نهیگز نیباشند اگر ا کیاز مناطق ممکن است تار یکند. برخ یم
 .شود یم هیاول شما باشد توص تیاولو نور از حد شیو کنترل ب ریتصو

⚫ Road :مانند جاده،  ع،یوس یبر صحنه ها ارتنظ یو برا برای محیط هایی که به طور کلی روشن هستندحالت  نیا

 .شود یم هیتوص

⚫ Park :یاز موانع مانند پارک ها یاریکوچک با بس ینظارت بر صحنه ها یو برا پیشنهاد کنواختینور  برای حالت نیا 

 .شود یم هیتوص یصنعت

⚫ Manual :کنترل شدت نور یدهد تا به صورت دست یحالت به شما اجازه م نیا IR دیرا کنترل کن. 

⚫ Indoor :شود یم هیتوص یداخل یکاربرد در صحنه ها یحالت برا نیا. 

Illumination 

Level  

خاموش  IR است که نور یمعن نیبه ا 0است.  شتریباشد، شدت ب شتریب مقدار. هر چه دیکن میرا تنظ IR شدت نور زانیم

 .است

⚫ Near-illumination Level :ریض اول این پارامتر را تنظیم کنید.پیشنهاد می شود برای صحنه ای با زاویه ع 

⚫ Mid-illumination Level : پیشنهاد می شود برای صحنه ای که فاصله کانونی متوسط دارد اول این پارامتر را

 تنظیم کنید.

⚫ Far-illumination Level :دیکن میپارامتر را تنظ نیداشته باشد، ابتدا ادور و تله  ریتصو کیبه  ازیاگر صحنه ن. 

  توجه :

 .شده باشد میتنظ Manualبه صورت   Control Modeکه  دیکن میتنظ یزمانپارامتر را فقط  نیا دیتوان یشما م

 .دیکن کیکل Default یفرض، رو شیپ ماتیبازگرداندن تنظ یبرا .3

Focus   

 

     
  

     
  

 .دینیبب اتیجزئ یوب را برا یطفا رابط واقعمدلها متفاوت باشد ل توجه به ت باممکن اس عملکرد نیا

 

 توجه!     

 .دینیبب اتیجزئ یوب را برا یعمدلها متفاوت باشد لطفا رابط واق توجه به ممکن است با عملکرد نیا توجه!     
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 کلیک کنید. Focus  روی سپس و شوید Setup > Image > Image وارد .1

  

 .دیانتخاب کنمورد نظر را  فوکوس حالت .2

 شرح  پارامتر

Focus Mode 

Auto Focus: کند یم فوکوس ینور فعل طیبه طور خودکار با توجه به شرا نیدورب. 

Manual Focus: دیکن میتنظ یرا به صورت دست نیدورب فوکوس. 

One-Click Focus: کند یم فوکوس بار کی ،شده میتنظ شیپ مکان از کیرفتن به  ای ییدن، بزرگنمایچرخ یبرا نیدورب. 

One-Click Focus (IR): به عملکرد بهتری با ، فوکوسحالت  نیا ک،یخانه تار ایشب  یکم نور مانند ساعتها طیدر شرا

 .می رسدروشن  IR ینورها

Scene  

Normal: یصنعتپارک مانند جاده و  متداول یصحنه ها یمورد استفاده برا. 

Long Distance: متر  30از  شیب نیکه دورب یشود. به عنوان مثال، هنگام یر جاده استفاده منظارت از راه دور د یبرا

 نصب شده است. دورای نظارت بر تقاطع جاده  یارتفاع برا

 .دیکن کیکل Default یفرض، رو شیپ ماتیبازگرداندن تنظ یبرا .3

 دیتعادل رنگ سف

چشم انسان ها  یشکل ممکن برا نیرا که به بهتر یریرنگ است تا تصاو تلفمخ یهادماتحت  ریدر تصاو یعیطب ریرنگ غ ضیتعو ندیفرآ یتعادل رنگ

.کند دیمناسب باشد، تول

 

 کلیک کنید. White Balance شده و سپس روی گزینه  Setup > Image > Image وارد  .1

  

 .دده یمهم را شرح م یپارامترها یبرخ ریجدول ز دیانتخاب کن ازیرا در صورت ن یدیحالت تعادل سف کی .2

 شرح  پارامتر

White Balance  

 :دیکن میرا تنظ ریتصو یآب ایقرمز  میزان ⚫

⚫ Auto/Auto2: یکند )رنگ به رنگ آب یم میرا تنظ یرنگ قرمز و آبمیزان نور،  طیبه طور خودکار با توجه به شرا نیدورب 

 .دیرا امتحان کن Auto2 لطفاند، هست یآب ایقرمز  یتریعیطب ریدر حالت خودکار هنوز حالت غ ریاست(. اگر تصاو متمایل

⚫ Fine Tune :دیکن میتنظ یرا به صورت دست یقرمز و آب میزاندهد که  یبه شما اجازه م. 

⚫ Outdoor :است شتریبا محدوده دما نسبتا ب رونیب طیمح یمناسب برا. 

⚫ Locked: رییبدون تغ یرنگ فعل یدماردن قفل ک. 

⚫ Sodium Lamp :را  یقرمز و آب میزان کیبه رنگ قرمز( اتومات متمایلنور ) طیبه شرا به طور خودکار با توجه نیدورب

 .کند یم میتنظ

  
  

 .دینیبب اتیجزئ یراوب را ب یاوت باشد لطفا رابط واقعمدلها متف توجه به ممکن است با عملکرد نیا

 

 توجه!     
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Red Offset  

 .دیکن میتنظ یرا به صورت دست یقرمز میزان

 توجه : 

 .شود میتنظ Fine Tuneبه حالت   White Balanceکه  دیکن میتنظ یپارامتر را فقط زمان نیا دیتوان یشما م

Blue Offset  

 .دیکن میتنظ یرا به صورت دست آبی رنگ میزان

 توجه : 

 .شود میتنظ Fine Tuneبه حالت   White Balanceکه  دیکن میتنظ یپارامتر را فقط زمان نیا دیتوان یشما م

 .دیکن کیکل Default یفرض، رو شیپ ماتیبازگرداندن تنظ یبرا .3

Advanced  

 .دیاستفاده کن عملکرد مه زدایی، از گرد و خاک ایمه و  طیگرفته شده در شرا ریوضوح تصاو میتنظ یبرا

 را انتخاب کنید. Advanced  شده و گزینه Setup > Image > Image  وارد .1

 
 .خاموش باشد WDR که دیکن میتنظ یپارامتر را تنها زمان نیا دیتوان یشما م ⚫

 9تا6  شدت مه زداییشود،  یم میتنظ On یبر رو Defog که یکنند. هنگام یم یبانیپشت ینور مه زداییاز  نیدورب یاز مدل ها یبرخفقط  ⚫

 شود؛ اگر یم میتنظ 6تا  5از سطح  مه زداییکه شدت  یکنند وقت یم رییتغ دی/ سف اهیبه س یاز رنگ ریو تصاو ،است ینور مه زدایی انگرینما

Defog به Auto دیو سف اهیبه طور خودکار به حالت س ری، تصاوداشته باشدقرار  9-6 نیب ییدر جا مه زداییشده باشد و سطح شدت  میتنظ 

 .شود یم لیتبد نوری مه زداییبه  نیسنگ مه طیبه صورت خودکار در شرا نیکنند. دورب ینم رییتغ سبکمه  طیدر شرا

 

و  ابدی یدست م مه زداییبه حداکثر اثرات  9. سطح دیصحنه انتخاب کن یسطح برا کیو سپس  کنیدفعال  مه زدایی را کردعمل .2

.رسد یبه حداقل م 1سطح 

 
   

 Defog Off  Defog On 

 .دیکن کیکل Default یفرض، رو شیپ ماتیبازگرداندن تنظ یبرا .3

Lighting Type  

  
  

 . کنید کلیک Smart Illumination  شده و سپس روی Setup > Image > Image وارد .1

  

  
  

  

 توجه!     

 .دینیبب اتیجزئ یوب را برا یمدلها متفاوت باشد لطفا رابط واقع توجه به ممکن است با عملکرد نیا توجه!     
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 .دیرا انتخاب کن  Lighting Type ییکشو ستیاز ل نهیگز کی .2

 .دیکن کیکل Default یفرض، رو شیپ ماتیبازگرداندن تنظ یبرا .3

و لنز IRISحالت  میتنظ

 
 دینیبب اتیجزئ یرا برا یشود. لطفا مدل واقع یم یبانیشبکه پشت باکس)صنعتی( یها نیفقط توسط انواع دورب عملکرد نیا •

 .دیوصل کن نیدورب Z/Fپورت به را  irisو کابل کنترل  دیاستفاده کن P-Iris لطفا از لنز با حالت کنترل •

• Iris کرد که  میتنظ یتوان تنها زمان یرا مLens Mode  به P-IRIS شود میتنظ. 

 

  

 را کلیک کنید. Advanced  شده و گزینه Setup > Image > Image  وارد .1

  

 .دهد یمهم را شرح م یپارامترها یبرخ ریجدول ز دیده رییتغ ازیرا در صورت ن ماتیتنظ .2

ترپارام  شرح  

Lens Mode  
• Z/F :و زوم فوکوس رییتغ یبرا.  

• P-Iris : مقدار رییتغ یبرا iris.  

Aperture 

Control  

iris  دیکن میتنظ یدست ایرا به صورت خودکار. 

 توجه : 

 .شده باشد میتنظ P-Iris به  Lens Modeکه  دیکن میتنظ یپارامتر را فقط زمان نیا دیتوان یشما م

F-Number  افراگمید یدست رییتغ 

  

 .دیکن کیکل Default یفرض، رو شیپ ماتیبازگرداندن تنظ یبرا .3

 OSDتنظیم 

.باشد یسفارش یمحتواها ریاست و ممکن است شامل زمان و سا ییدئویو ریصفحه با تصاو یداده شده رو شیمتن نما ،(OSD) صفحهروی  شینما

 

  

  Setup > Image > OSD  مراحل زیر را انجام دهید : .1

  
  

  

     

 توجه!     

 .دینیبب اتیجزئ یب را براو یها متفاوت باشد لطفا رابط واقعمدل توجه به ممکن است با عملکرد نیا توجه!     
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 شود یداده م شینما ریاز مدل ها به صورت ز یبرخ OSD رابط

.  

 .دیرا انتخاب کن OSD یو محتوا تیموقع .2

• Position: جعبه دلخواه در منطقه یرو Live View تا کادر را به  دیشکل مکان نما، دکمه را فشار داده و نگه دار ریی. پس از تغدیکن کیکل

 .دیاستفاده کن Overlay Area ریدر ز Y و X از مختصات ت،یموقع قیدق میتنظ ی. برادیدلخواه حرکت ده تیموقع

• Overlay OSD Content: دیتوان یم نیکند. شما همچن یرا فراهم م الیشده و سر نییتع شیپمکان از اطلاعات زمان،  ییکشو ستیل 

 .دیوارد کن دیخواه یرا که م یاتیرا انتخاب کرده و محتو یسفارش

شده  میتنظ تیبا موفق OSD که یمعن نیشود، به ا یظاهر م تیدر ستون وضع نماد  د،یکرد میرا تنظ OSD یو محتوا تیموقع نکهیبعد از ا •

 .دیکن میتنظرا  شیدنباله نما و  با استفاده از  و  دیکن میهر منطقه تنظ یرا برا اتیاز محتو یخطوط مختلف دیتوان یاست. شما م

 .نشان داده می شود زیآم تیموفق ماتیتنظ یبرا امیپ کی مات،یپس از اتمام تنظ .3

 دیتوان یم نی. شما همچنرا انتخاب کنید نسبت ابعاد ایمشاهده در حالت تمام صفحه و ،  شینما شیپنجره پ یراست بر رو کیبا کل دیتوان یم شما

 .دخارج شوی و مجددا دیتا به حالت تمام صفحه وارد شو دیکن کیدوبار کل شینما شیپنجره پ

 .دیکن لغو  Position ستونعلامت را در  ای پاک کنید Content OSD Overlay  ستونرا در  OSD یمنطقه، محتوا کی یبرا OSD لغو یبرا

 .دهد یزمان را نشان م OSD مثال کی ریز
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 ماسک حریم خصوصی

ظت از حریم خصوصی، به عنوان مثال، صفحه کلید دستگاه در موارد خاص، ممکن است نیاز به تنظیم یک ناحیه ماسک در تصویر دوربین برای حفا

تنظیم  مجددابه این ترتیب برای محافظت از منطقه  Privacy Mask موقعیت یا زوم خود را تغییر می دهد،  PTZ خودپرداز داشته باشید. هنگامی که

 .می شود

 
 

  Setup > Image > Privacy Mask  مراحل زیر را انجام دهید .1 

   
 :صفحه به صورت زیر نمایش داده می شودای برخی از مدل های دوربین، رب

  

  

     

 توجه!     

 .دینیبب اتیجزئ یوب را برا یمدلها متفاوت باشد لطفا رابط واقع توجه به ممکن است با عملکرد نیا •

ماسک خصوصی را نشان  8ا تصویر فقط ت اینخصوصی را پشتیبانی می کنند. حریم ماسک  24برخی از مدل ها تا  •

 می دهد.
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 .کلیک کنید روی  کلیک کنید و برای پاک کردن ماسک روی  خصوصی حریم ماسک کردن اضافه برای.2

. پس از تغییر شکل مکان دمی شوفعال ماسک )با ماسک نمایش داده شده در آن(  تصویربرای مخفی کردن موقعیت: با کلیک بر روی  •

 .نما، کادر را به موقعیت مورد نظر بکشید

 .در منطقه ای که می خواهید ماسک کنید شکلبرای مسدود کردن یک منطقه: با استفاده از موس برای رسم یک  •

 .. مثال زیر نشان می دهدمی شودمسدود  وقتی ماسک حریم خصوصی پیکربندی شده ، قسمت مورد نظر

  

 

 

 

 

 صوتی و تصویری بندیپیکر

 بندی تصویریرپیک

. در صورت موجود دیرا مشاهده کن BNC یخروج یفعل تیو وضع دیکن میکند تنظ یم یبانیشما پشت نیرا که دورب یریتصو یپارامترها دیتوان یشما م

.دیفعال کن ازیو سوم را در صورت ن تصویری دوم انیجر دیتوان یم نیبودن، شما همچن

 
 ایآ نکهیا نییتع یکند. برا یم یبانیسوم پشتتصویری  انیاز جر نیدورب یاز مدل ها یمدلها متفاوت باشد. فقط برخکن است با عملکرد مم نیا •

 .دینیکند، رابط وب را بب یم یبانیعملکرد پشت نیشما از ا نیدورب

 همانند یمشابه یو سوم معان تصویر دوم انیجر یمترها. پارادیده رییرا تغ ازیمورد ن یسوم، پارامترها ای تصویری دوم انیپس از فعال کردن جر •

.دارند یاصل انیجر

 

  

  .Setup > Video & Audio > Video  مراحل زیر را طی کنید : .1

 توجه!       
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 .دهد یمهم را شرح م یپارامترها یبرخ ریجدول ز دیده رییتغ ازیرا در صورت ن ماتیتنظ .2

 شرح  پارامتر

Video  
Compression  

  H.265, H.264 and MJPEG:  نهیسه گز

 یشود. هنگام ینم میتنظ ریتصو تیفیشود، ک یم میتنظ H.264 ای H.265 به یفشرده ساز حالتکه  یهنگام ⚫

 Bit Rate, I Frame؛ و 5و  3، 1در دسترس هستند:  میفر سرعت شود، فقط سه یم میتنظ MJPEG که به

Interval, Smoothing and U-Code کرد میتوان تنظ یرا نم. 

 تیکند. نرخ ب یم رییفرض تغ شیبه طور پ ریت تیب د،یده رییرا تغ H.265 و H.264 نیب ماتیکه تنظ یهنگام ⚫

 .است H.264 نصف H.265 یفرض برا شیپ ریت

Frame Rate  
 (هیثان بر میفر) FPS :. واحدتصویربرداری یبرا مینرخ فر

 .از سرعت شاتر باشد شتریب دینبامتقابلا  میکه نرخ فر دیتوجه داشته باش ر،یتصو تیفیاز ک نانیاطم یبرا

Bitrate Type  
⚫ CBR :دهد یداده ها را با نرخ داده ثابت انتقال م نیاست که دورب یمعن نیثابت، به اریت  تیب. 

⚫ VBR: کند یم میتنظ ریتصو تیفیرا با توجه به ک ریت تیبا ب نیاست که دورب یمعن نیبه ا ر،یمتغریت  تیب. 

Image Quality  

 ریتصاو یبرا تیفیسطح ک میتنظ یرا برا متحرکنوار  دیتوان یاست، شما م  Encoding Mode   ،VBRکه  یهنگام

 ریتصو تیفیدهد و ممکن است ک یرا کاهش م ریت تیسرعت ب Bit Rate به سمت متحرک. حرکت نوار دیحرکت ده

 .قرار دهد ریرا تحت تاث

  .بخشد یرا بهبود م ریتصو تیفیدهد و ک یم شیرا افزا تری تیب ،  Qualityبه سمت  متحرکنوار  حرکت

I Frame Interval  
دهد، اما  یبهتر را ارائه م ریتصو تیفیک  i فاصله کوتاه کیشود. به طور معمول،  یم ساخته i میفر کیکه  یفاصله زمان

 .کند یرا مصرف م یشتریباند ب یپهنا

GOP  
 یها میو فر (I frame) ها میکند که درون فر یپارامتر مشخص م نیااست.  MPEG دئویو ساختدر  ریگروه تصاو

 .مرتب شده اند زیرشاخه

SVC  SVC را کاهش دهد یساز رهیپخش، ذخ تیفیرساندن ک بیتواند بدون آس ی( مریپذ اسیمق یلمبرداری)ف.  

U-Code  • Basic Mode: شده است میتنظ ریت تیاز ب %75حدود  یواقعریت  تیب. 
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رپارامت  شرح  

 ⚫ Advanced Mode :شده است میتنظ ریت تیب %50حدود  یواقعریت  تیب. 

 .کند یم یبانیپشت H.265 و H.264 تنها از دئویو یشود، فشرده ساز یفعال م U-Code که یهنگام ⚫

MJPEG شود ینم یبانیپشت 

 .کند ینم ینبایپشت 30بالاتر از  یها میاز فر فیلمبرداریشود، حالت  یفعال م U-Code که یهنگام ⚫

Smoothing  

به  نشانگراست. حرکت  Smoothingی رفعالسازیغ یبه معنا  Clear. انتخاب دیکن میرا تنظ روانی تصویر زانیم

 .دهد یقرار م ریرا تحت تاث ریتصو تیفیدهد اما ک یم شیرا افزا روان بودن تصویرسطح  Smooth سمت

 .دیکن افتیدر یشتریروانتر ب یوهایدیتا و دیال کنفع را Smoothing دیتوان یم ف،یشبکه ضع طیمح کیدر 

BNC Output  یخروج BNC از NTSC و PAL کند یم یبانیپشت. 

3. Save  کنید.را کلیک  

 پیکربندی صوتی

.شما است نیدورب یبرا یصوت ضبط های یپارامترها میتنظ یبه معن یصوت یکربندیپ

 

  .Setup > Video & Audio > Audio :  مراحل زیر را طی کنید .1

  
 .دهد یمهم را شرح م یپارامترها یبرخ ریجدول ز دیده رییتغ ازیرا در صورت ن ماتیتنظ .2

 شرح  پارامتر

Audio Input  

 .نخواهد شد برداشت یاطلاعات صوت چیشود ه یانتخاب م  Off یوقت

عملکرد دستگاه را  یتواند تا حدود یامر م نی. ادیرا انتخاب کن  Offاگر نیاز به پردازش صدا ندارید شود  یم هیتوص

  .بهبود بخشد

Access Mode  

 .کروفنیدر حال حاضر تنها خط / م

 .ستیموجود ن یصوت یبا دو کانال خروج ییدستگاه ها یعملکرد برا نیا

Audio  

Compression  

 ACC-LC  و  G.711U ،G.711A : نهیسه گز

G.711U و G.711A  8تنهاK  کنند و یم یبانیرا پشت یرینمونه گ ACC-LC 8 یاز نرخ نمونه بردارK ،16K  48وK 

  .کند یم یبانیپشت

  

  

 .دینیبب اتیجزئ یوب را برا یمدلها متفاوت باشد لطفا رابط واقع توجه به ممکن است با عملکرد نیا

 

 توجه!     
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 شرح  پارامتر

Input Gain  شتریب تیتقو ش،یافزا نیشتری. بینمونه بردار یبرا یصوت گنالیس تیتقو. 

Noise  
Suppression  

 .دیکن یککل  On یفعال کردن ، رو یشود. برا یاستفاده م ریدر تصاو زیکاهش نو یبرا

Channel  
 .بزنیدرا  Enable ،یصوت یفعال کردن خروج یبرا یصوت یکانال خروج

  .کند یم یبانیدو کانال را پشت نیدورب یاز مدل ها یبرخ فقط

3. Save  . را بزنید 

 فوریعکس 

 . شوید Setup > Video & Audio > Snapshot  وارد .1

  

2. On کنید میتنظ ازین با توجه بهرا  زمانی و برنامه سایز نیو سپس رزولوشن، بزرگ تر ، دیرا انتخاب کن . 

 .شرح داده شده است ریاز پارامترها در جدول ز یبرخ

 شرح  پارامتر

Snapshot Interval  
ثانیه می  1عکس به فاصله زمانی  2تنظیم شده باشد ،  2و تعداد روی  1فوری. اگر فاصله فاصله بین دو عکس 

  از یک ثانیه دومی را میگیرد( گیرد.)اولی را میگیرد و پس

Number to Snapshot   عکس مجاز هستند 3و  2، 1در حال حاضر. 

Snapshot Mode  

Schedule : نیاست که دورب یمعن نی، به ا19:12:00به عنوان مثال،  د،یکن نییرا تع یزمان عکس فور دیشما با 

 .کند یم یعکسبردار 19:12:00در ساعت 

Repeat : ماتی. به عنوان مثال، با توجه به تنظدیکن می( را تنظهیفاصله )واحد: ثان کیدهد  یجازه مبه شما ا 

 .بگذرد تا تکرار کند دیبا ،گرفت یدو عکس فور نیدورب نکهیاز ا هیثان 60نشان داده شده در شکل بالا، 

3.  Save . را بزنید 
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ROI  

 .نباشد ریت کافی تیکند اگر ب یفراهم ماولویت  بارا  ROI یبرا ریتصو تیفیک ستمیشود، س یفعال م (ROI) مور علاقهکه منطقه  یهنگام

  
  

  

 پیکربندی جریان تصویر

 جریان تصویر

را با  صویریت انیتا جر دیکن میرا تنظ نیدورب دیتوان یم نی. شما همچندیده شیرا نما نیدورب کیشده از  جادیا تصاویر انیجر دیتوان یشما م

 ن،یدورب روشن شدن مجددکرد و بعد از  رهیتوان ذخ یرا م ماتیو شماره پورت مشخص انتقال دهد. تنظ IP آدرس کیبه  TCP ای UDP پروتکل

 .اعمال می شود

 
 دینیبب اتیجزئ یرا برا یشود. لطفا مدل واقع ینم یبانیاز مدل ها پشت یبرخدر عملکرد  نیا ⚫

را فراهم  UDP بهتر از ریتصو تیفیک TCP ،ی. به طور کلکنید انتخابخود بکه و عملکرد ش یواقع یازهایبر اساس ن انتقالپروتکل  کی ⚫

 .شود یم زین شتریب ریباعث تأخ در مقابلکند،  یم

 

  

 .  شوید Setup > Video & Audio > Media Stream  وارد .1

  

          شوید. Setup>Video & Audio>ROIوارد .1  

  

ا پوشش دهد. برای حذف، منطقه را انتخاب کنید و از تصاویر ر موردنظرکلیک کنید و سپس موس را بکشید تا بخش    روی. 2

 کلیک کنید روی سپس 

  

 .دینیبب اتیجزئ یوب را برا یواقعمدلها متفاوت باشد لطفا رابط  توجه به ممکن است با عملکرد نیا

 

 توجه!     

 توجه!     
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 یرا برا multicast ای unicast و شماره پورت گروه IP و سپس آدرس دیرا انتخاب کن انینوع جر کیسپس  د،یکن کلیک روی  .2

 .دیکن میتنظ دیکن یم افتیدر نیرا از دورب یریو تصو یصوت یها انیکه جر گیرنده ایدستگاه 

انتخاب  Persistentرا برای   Yesتنظیماتی که اعمال کرده ای را مجددا بعد از ریستارت شدن ادامه دهد گزینه دستگاه  دیخواه یم اگر

 کنید

 .دیکن کیکل ی رو ان،یجر کیحذف  یبرا. 3

 .دیکن کیکل Submit یرو اتیعمل لیتکم یبرا. 4

 RTSP یآدرس چندرسانه ا

از  RTP پروتکل قیرا از طر RTSP یرسانه چندرسانه ا انیتواند جر یکننده شخص ثالث م، پخش  RTSP یآدرس چندرسانه ا کتنظیم یپس از 

 .درخواست کند نیدورب

  Setup > Video & Audio > Media Stream > RTSP Multicast Address :  مراحل زیر را طی کنید .1

  
 .شود یداده م شینما ریصفحه به صورت ز ن،یدورب یاز مدل ها یبرخ یبرا



 

34 

  

 .دیکن می( را تنظ65535تا  0( و شماره پورت )239.255.255.255تا  224.0.0.0) یآدرس چندرسانه ا. 2

3 .Save . را بزنید 

 وشمندهشدار ه یکربندیپ
نفوذ  صی. نظارت هوشمند شامل شمارش افراد، تشخدیکن یکربندیپ اءیشمارش افراد و نظارت بر حرکت اش ینظارت هوشمند را برا دیتوان یشما م

 .خودکار است یابیو رد

 .متفاوت باشند نیشده ممکن است با مدل دورب یبانیپشت عملکردهای

 

 تنظیمات هوشمند

 . شوید Setup > Intelligent > Smart Settings  وارد
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 .شود یداده م شینما ریصفحه به صورت ز ن،یدورب یاز مدل ها یبرخ یبرا

  

 عبور از خط فرضی

که  یهنگام هشدار دادندهد و باعث  یم صیکنند، تشخ یعبور م فرضیخط  کیاز  تصویر زندهرا که در  ییایاش ،خط فرضیعبور از  صیتشخ

 .شود یم یی شود،شناسا یدادیرو نیچن

 کلیک کنید .   را انتخاب کرده و روی  Cross Line شده و سپس Setup > Intelligent > Smart Settings  وارد .1
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2. Cross Line Detection دیرا انتخاب کن. 

 یرو ص،یمنطقه تشخ کیحذف  ی. برادیکن کیکل روی  دیجد صیمنطقه تشخ کیافزودن  یبرا ،Detection Ruleدر منطقه  .3

 .دیکن کیکل

 .دیکن میرا تنظ صیو محدوده تشخ دیمورد نظر بکش تیکوچک، خط را به موقع شینما شیدر پنجره پ .4

 .دهدرا گزارش  فرضیخط  صیتشخچطور هشدار که  دیریبگ میتا تصم دیکن نییرا تع نیدورب تیجهت و حساس .5

 تحریک هشداراز  یاقدامات ناش حاتیتوض ق،یمراحل دق یبرا. دیکن میتنظ ازیرا در صورت ن فعالیتهشدار و برنامه  تحریکاز  یاقدامات ناش .6

 .دیحرکت مشاهده کن صیتشخ هشدار یکربندیرا در پ

7. Save  بزنید .را 

 تشخیص ورود به محدوده

شود،  یم ییشناسا دادیرو کیکه  یکند و زمان یم ییشناساتصویر زنده وارد محدوده مشخصی می شوند در  کهرا  اءی، اشورود به محدوده صیتشخ

 .کند یم هشدار را فعال

 کلیک کنید.   رویرا انتخاب کرده و   Intrusion و شده Setup > Intelligent > Smart Settings  وارد .1
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2. Intrusion Detection دیرا انتخاب کن. 

 یرو ص،یمنطقه تشخ کیحذف  ی. برادیکن کیکل روی  دیجد صیمنطقه تشخ کیافزودن  یبرا ،Detection Ruleدر منطقه  .3

 .دیکن کیکل

 .دیرا بکش شکل یو محدوده مورد نظر، مرزها تیموقع میتنظ یبرا .4

 .گزارش شود ورود صیتشخ هشدار کی ایآ نکهیا نییتع یبرا نیدورب یو درصد برا ت،یآستانه زمان، حساس میتنظ .5

⚫ Time Threshold : هشدار گزارش شود کی نکهیشود قبل از ا یداده م صیکه مهاجم در منطقه تشخی حداقل زمان. 

⚫ Sensitivity : است شتریب صیتشخ تیحساس یبه معنا شتریمقدار ب،  صیتشخ تیحساس. 

⚫ Percentage :  هشدار.قبل از گزارش  معین شده صیبه اندازه منطقه تشخ جسم وارد شده ابعادحداقل نسبت 

 

تحریک از  یاقدامات ناش حاتیتوض ق،یمراحل دق ی. برادیکن میتنظ ازیرا در صورت ن فعالیتهشدار و برنامه  تحریکاز  یاقدامات ناش .6

 .دیحرکت مشاهده کن صیتشخ هشدار یکربندیرا در پ هشدار

7. Save . را بزنید 

 جابجایی اشیاء

 .به صدا در می آوردکرده و هشدار را  ییشده اند شناساجابجا مشخص شده  هیرا که در ناح اءیاش

 کلیک کنید.  را انتخاب کرده و روی   Object Movingشده و   Setup > Intelligent > Smart Settings وارد  .1
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2. Object Moving دیرا انتخاب کن. 

 یرو ص،یمنطقه تشخ کیحذف  ی. برادیکن کیکل روی  دیجد صیمنطقه تشخ کیافزودن  یبرا ،Detection Ruleدر منطقه  .3

 .دیکن کیکل

 .دیرا بکش لشک یو محدوده مورد نظر، مرزها تیموقع میتنظ یبرا .4

 .دهد یا خیرنفوذ را گزارش  صیهشدار تشخ کی ایکه آ ردیبگ میتا تصم دیکن میرا تنظ تیآستانه زمان و حساس .5

⚫ Time threshold : زنگ خطر است جادیا یدر منطقه مشخص شده برا یش کی زمان حداقل مدت. 

⚫ Sensitivity : ییطول مدت مشخص شده شناسا یطقه مشخص شده برامن در یش کیبالاتر است. اگر  تیباشد، حساس شتریهرچه عدد ب 

 .شود یهشدار گزارش م کیشود، 

تحریک از  یاقدامات ناش حاتیتوض ق،یمراحل دق ی. برادیکن میتنظ ازیرا در صورت ن فعالیتهشدار و برنامه  تحریکاز  یاقدامات ناش .6

 .دیحرکت مشاهده کن صیتشخ هشدار یکربندیرا در پ هشدار

7. Save د .را بزنی 

 اشیاءبرداشتن 

 .به صدا در می آوردکرده و هشدار را  ییشده اند شناسا حذفمشخص شده  هیرا که در ناح اءیاش

 . کلیک کنید   را انتخاب کنید سپس روی  Object Left و شده Setup > Intelligent > Smart Settings  وارد .1
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2. Object Left دیرا انتخاب کن. 

 یرو ص،یمنطقه تشخ کیحذف  ی. برادیکن کیکل روی  دیجد صیمنطقه تشخ کیافزودن  یبرا ،Detection Ruleدر منطقه  .3

 .دیکن کیکل

 .دیرا بکش شکل یو محدوده مورد نظر، مرزها تیموقع میتنظ یبرا .4

 .دهد یا خیرنفوذ را گزارش  صیهشدار تشخ کی ایکه آ ردیبگ میتا تصم دیکن میرا تنظ تیآستانه زمان و حساس .5

⚫ Time threshold : زنگ خطر است جادیا یدر منطقه مشخص شده برا یش کی زمان حداقل مدت. 

⚫ Sensitivity : ییطول مدت مشخص شده شناسا یدر منطقه مشخص شده برا یش کیبالاتر است. اگر  تیباشد، حساس شتریهرچه عدد ب 

 .شود یهشدار گزارش م کیشود، 

تحریک از  یاقدامات ناش حاتیتوض ق،یمراحل دق ی. برادیکن میتنظ ازیرا در صورت ن فعالیتهشدار و برنامه  تحریکاز  یاقدامات ناش .6

 .دیحرکت مشاهده کن صیتشخ هشدار یکربندیرا در پ هشدار

7. Save . را بزنید 

 تشخیص چهره

 .دهد یم صیزنده تشخ نمایشرا در  یانسان یچهره ها ،چهره صیتشخ

 را بزنید.   کلیک کرده و  Face ه و روی گزینهدش Setup > Intelligent > Smart Settings  وارد .1
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 .دیو محدوده مورد نظر بکش تیموقع نییتع یمرزها را برا .2

 .کنید میتنظی واقع یازهایبا توجه به ن را صیتشخ یپارامترها .3

تحریک از  یات ناشداماق حاتیتوض ق،یمراحل دق ی. برادیکن میتنظ ازیرا در صورت ن فعالیتهشدار و برنامه  تحریکاز  یاقدامات ناش .4

 .دیحرکت مشاهده کن صیتشخ هشدار یکربندیرا در پ هشدار

5. Save . را بزنید 

 کلیک کنید. Start Intelligent Analysis روی گزینه  .6

 شمارش افراد

 
  

 .کند یم یبانیرا پشت عملکرد نیا نیدورب یاز مدل ها یفقط برخ ⚫

 .دینیوب را بب یواقع یرابط کاربر اتیمتفاوت باشد. لطفا جزئ نیا مدل دوربممکن است ب زمانی فعالیتو برنامه  تحریک هشدار ⚫

 

 

 

 را بزنید.  انتخاب کرده ورا  People Counting شده و سپس Setup > Intelligent > Smart Settings وارد .1

  

  

             

 توجه!     
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2. Enable Passenger Flow Detection میرا تنظ تیرش و حساسفاصله گزا د،یرا انتخاب کن صیحالت تشخ .دیرا انتخاب کن 

 .دیکن

 کیدر سمت چپ، به عنوان مثال،  شینما شیدر پنجره پ صیمنطقه تشخ کیو سپس  دیکن کیکل Draw Detection Area یرو .3

 .بکشید مربع

. جهت معمولا دیدر سمت چپ بکش شینما شیو سپس جهت را در پنجره پ دیکن کیکل Draw Entrance Direction یرو .4

 .دار است بیش ای یعمود

شوند  یم لتریف گرانیشوند؛ د یاندازه شمارش م این در محدوده اءی. فقط اشدیکن میتنظ Filter by Object Sizeزیر  را و حداقل سایز حداکثر .5

 .ارتفاع باشد ایاز حداقل عرض  شتریب دیارتفاع با ایشوند. حداکثر عرض  یو شمارش نم

تحریک از  یاقدامات ناش حاتیتوض ق،یمراحل دق ی. برادیکن میتنظ ازیرا در صورت ن الیتفعامه هشدار و برن تحریکاز  یاقدامات ناش .6

 .دیحرکت مشاهده کن صیتشخ هشدار یکربندیرا در پ هشدار

 .دیکن کیکل Clear Counting Result یشمارش، بر رو جینتا صفرکردن یبرا .7

8. Save . را بزنید 

 دنبال کننده اتوماتیک

.کند یرا دنبال م شامل قوانین می شودکه  یش کیودکار به طور خ نیدورب

 
 .کند یم یبانیرا پشت عملکرد نیا نیدورب یاز مدل ها یفقط برخ ⚫

 .دینیوب را بب یواقع یرابط کاربر اتیمتفاوت باشد. لطفا جزئ نیممکن است با مدل دورب زمانی فعالیتو برنامه  تحریک هشدار ⚫

 

  

 توجه!       
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 .کلیک کنید  را انتخاب کنید و روی Auto Tracking و شده Setup > Intelligent > Smart Settings وارد .1

  

 .کنید میتنظرا  ( و نسبت زومهی)واحد: ثان یابیزمان رد .2

3. Save . را بزنید 

 نقشه حرارتی

نشان دهنده تراکم  قرمز، به عنوان مثال ره،یکند. رنگ ت یکننده استفاده م دیبازد کیتراف یالگوها شینما یمختلف برا یاز رنگ ها حرارتینقشه 

 .است شتریب کیتراف

 کلیک کنید.  را انتخاب کنید ، روی گزینه Heat Map و شده Setup > Intelligent > Smart Settingsوارد  .1

 

 

 

 

 

 

 

 

 

 

2. Enable  دیکنرا انتخاب. 

3. Background Update Rate شود به روز می عتریسر ریباشد، تصو شتریمقدار ب. هرچه دیکن میرا تنظ . 

4. Sensitivity شوند ییکوچک شناسا یایاحتمال دارد که اش شتریباشد، ب شتریب مقدار. هرچه دیکن میرا تنظ. 

5. Min. Object Size  شوند یگرفته م دهیناد صیباشد، اجسام کوچکتر در هنگام تشخ شتری. هرچه مقدار بکنید میتنظرا. 
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 .کنید میتنظسیستم را به  یگزارش آمار یبرا یروز رسان فاصله به .6

تحریک از  یاقدامات ناش حاتیتوض ق،یمراحل دق ی. برادیکن میتنظ ازیرا در صورت ن فعالیتهشدار و برنامه  تحریکاز  یاقدامات ناش .7

 .دیحرکت مشاهده کن صیتشخ هشدار یکربندیرا در پ هشدار

8. Save . را بزنید 

فوکوس یختگیبهم ر صیتشخ

 
 .کند یم یبانیرا پشت ملکردع نیا نیدورب یاز مدل ها یفقط برخ  ⚫

 .دینیوب را بب یواقع یرابط کاربر اتیمتفاوت باشد. لطفا جزئ نیممکن است با مدل دورب زمانی فعالیتو برنامه  تحریک هشدار ⚫

 

  

 .دیگزارش ده یدادیرو نیچن ییرا هنگام شناسا هشدار کیو  دیاستفاده کن نیدورب تاری صیتشخ یبرا بهم ریختگی فوکوس صیاز تشخ

 کلیک کنید.   را انتخاب کرده و روی  Defocus و شوید Setup > Intelligent > Smart Settings  دوار .1

  

2. Defocus Detection .را انتخاب کنید 

 ارتحریک هشداز  یاقدامات ناش حاتیتوض ق،یمراحل دق ی. برادیکن میتنظ ازیرا در صورت ن فعالیتهشدار و برنامه  تحریکاز  یاقدامات ناش .3

 .دیحرکت مشاهده کن صیتشخ هشدار یکربندیدر پرا 

4. Save . را بزنید 

یبردار لمیصحنه ف رییتغ صیتشخ

 
 .کند یم یبانیرا پشت عملکرد نیا نیدورب یاز مدل ها یفقط برخ ⚫

 .دینیرا ببوب  یواقع یرابط کاربر اتیمتفاوت باشد. لطفا جزئ نیممکن است با مدل دورب زمانی فعالیتو برنامه  تحریک هشدار ⚫

 

  

که  یزمان هشدارو گزارش  نیدورب یمانند چرخش عمد یاز عوامل خارج ینظارت شده ناش طیمح رییتغ صیتشخ یصحنه برا رییتغ صیتشخاز 

 .دیشود، استفاده کن یم ییشناسا یدادیرو نیچن

 کلیک کنید.   رویرا انتخاب کرده و   Scene Change و شده Setup > Intelligent > Smart Settings  وارد .1

  

  

 توجه!     

 توجه!     
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2. Scene Change Detection .را انتخاب کنید 

 تحریک هشداراز  یاقدامات ناش حاتیتوض ق،یمراحل دق ی. برادیکن میتنظ ازیرا در صورت ن فعالیتهشدار و برنامه  تحریکاز  یاقدامات ناش .3

 .دیحرکت مشاهده کن صیتشخ هشدار یکربندیرا در پ

4. Save . را بزنید 

 شرفتهتنظیمات پی

 .هوشمند است عملکردهای یبرا صیو حالت تشخ یشامل وضوح عکس فور شرفتهیپ ماتیتنظ

 عکس یپارامترها

 .دیکن میرا تنظ یفور یوضوح عکس ها

  .را انتخاب کنید.  Photo parameters شده و Setup > Intelligent > Advanced Settings  وارد .1

  

 .دیکن میرا تنظ ریوضوح تصو .2

3. Save نید .را بز 

 

  

 

  
 .دیچهره را خاموش کن صیپارامتر عکس، تشخ میقبل از تنظ

    

 توجه!     



 

45 

 

 

صیتشخ یپارامترها

 
 .دینیوب را بب یواقع یرابط کاربر اتیکند. لطفا جزئ یم یبانیپشت شرفتهیپ ماتیاز تنظ نیدورب یاز مدل ها یفقط برخ ⚫

 کنید. ازیاست. به صورت مورد ن Normal Modeفرض  شیپ صیحالت تشخ ⚫

 

  

 را باز کنید.  Detection parametersصفحه  شوید و Setup > Intelligent > Advanced Settings   وارد .1

  

  

از  یناش یتکرار هشدارتا گزارشات مربوط به  دیرا انتخاب کن Filter Repeated Motion Mode . دیرا انتخاب کن صیحالت تشخ .2

 .شود خوددارینظارت  طیدر مح یحرکت تکرار

3. Save . را بزنید 

 پیکربندی هشدار معمولی

باعث شود تا آلارم و  گرید یتواند توسط دستگاه ها یکه م دیرا انجام ده یو اقدامات دیکن میرا تنظ هشداروط به مرب یاگزارش ه دیتوان یشما م

 .رندیمورد استفاده قرار گمشخص بتوانند در زمان  پس از آناقدامات 

 یزیصدا برنامه ر صیو تشخ اریخرابک صی، هشدار تشخهشدار یهشدار، خروج یحرکت، ورود صیتشخ هشدار یتوان برا یهشدار را م گزارش

 .دینیکند، رابط وب را بب یم یبانیشما را پشت نیانواع هشدار که دورب یشده ممکن است با مدل دستگاه متفاوت باشند. برا یبانیپشت ی. آلارم هاکرد

 حرکت صیهشدار تشخ میتنظ

 تیحساس ص،یمنطقه تشخ کی دی. شما بای دهدم صیشخترا دوره  کیمشخص در طول  یلیمنطقه مستط کیدر  یحرکت ش ،حرکت صیتشخ

 .حرکت را گزارش دهد صیتشخ هشدار یحرکت صیتشخ چه که هنگام ردیبگ میتصم نیتا دورب دیکن میرا تنظ خیو تار شی ابعاد ص،یتشخ

 
 دینیبب اتیجزئ یرا برا یشود. لطفا مدل واقع ینم یبانیاز مدل ها پشت یبرخ در عملکرد نیا ⚫

 .دینیوب را بب یواقع یرابط کاربر اتیممکن است با مدل ها متفاوت باشد. لطفا جزئ هشدار از یاشاقدامات ن ⚫

 

  

 تشخیصقه طمن

 تغییر دهید. Area  را به  Detection Mode شده و Setup > Events > Common Alarm > Motion Detection  وارد .1

 

 

 

 

 

  

  

 توجه!     

 توجه!     
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 کیکل ی رو ص،یمنطقه تشخ کیحذف  ی. برادیکن کیکل روی  دیجد صیطقه تشخمن کی افزودن یبرا ،  Detection Areaدر  .2

 دیکن

 .دیو بکش گرفتهموس را  نشانگر ص،یمنطقه تشخ کی نییتع یبرا .3

 یا خیر حرکت را گزارش کند صیتشخ هشدار کی ایآ ردیبگ میتصم نیتا دورب دیکن میرا تنظ خیو تار ءیاندازه ش ص،یتشخ تیحساس .4

 مقداراز اندازه  شیب صیتشخ هیحرکت در ناح زانیکه م یشود. هنگام یم صیتشخ تیحساس شیسمت راست باعث افزا به نگرنشاحرکت  ⚫

 .دهد یهشدار را گزارش م یک نی، دوربشود مورد نظر

 صیتشخ یراب گر،یکند. به عبارت د یمتعیین  هشدار از گزارش شیرا پ صیبه اندازه منطقه کل تشخ یحداقل نسبت اندازه ش ،ییاندازه ش ⚫

 .بکشیدآن  یحرکت بر رو ی( را در قسمت واقعصیکوچک )منطقه تشخ محیط کی دیحرکت اجسام کوچک، شما با

 کیهستند. هرچه طول  مربوطهحرکت  صی. خطوط قرمز نشانگر آلارم تشخمی شودنشان داده شده  به طور لحظه ایحرکت  صیتشخ جینتا ⚫

 .حرکت است شتریبتکرار ر، ت راکممتاست. خطوط  بیشتر حرکت ، شتریب خط

  
  

 .دیکن میهشدار را تنظ یپارامترها .5

⚫ Suppress Alarm(s) :  شود یشده گزارش نم نیی، هشدار مشابه در مدت زمان تعفعال شدن یک هشدارپس از. 

⚫ Clear Alarm(s) : بعد از اینکه یک هشدار فعال شد. 

 .تواند دوباره گزارش شود یم زیار پاک خواهد شد و هشدار ند، هشدنشو فعالشده  نییاگر هشدار مشابه در مدت زمان تع ❖

نشود، حذف نخواهد شد. سپس  یمنقض تعیین شدهکه زمان  یشده فعال شود، هشدار تا زمان نییاگر هشدار مشابه در مدت زمان تع ❖

 .تواند دوباره گزارش شود یمهشدار همان 

 .انجام شود زمانی حرکت و برنامه صیتشخ ارهشدکه توسط  دیکن میرا تنظ پس از هشدار اقدامات .6

 

 .دهد یم حیرا توض زمانی برنامه کی میمهم و نحوه تنظپس از هشدار اقدامات  ریجدول ز
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 شرح  پارامتر

Alarm  

Output 1  

 .متصل می کندحرکت  صیتشخهشدار  را بههشدار  یرابط خروج میتنظ نی. ادیرا انتخاب کن گزینه

دستگاه شخص  کیشود تا اقدامات توسط  یهشدار م فعال شدن خروجیباعث  نیشود، دورب یمگزارش هشدار  کیکه  یهنگام

  .ثالث را باعث شود

Goto  Preset  

 .دیکن میحرکت را تنظ صیتشخ هشدارفرض مربوط به  شیپ مکانو  دیرا انتخاب کن گزینه

پارامتر را  نیا دیتوان یصورت، شما نم نیا ریدر غ. دیکرده ا میفرض را تنظ شیپمکان  ماتیکه تنظ دیحاصل کن نانیاطم •

 .دیفرض مراجعه کن شیپمکان  ماتیبه تنظ م،یتنظ شیپمکان  میدر مورد نحوه تنظ شتریب اتیجزئ ی. برادیکن میتنظ

شود تا  یم میتنظ خودکار به مکان از پیش تعیین شده به صورت PTZ نیشود، دورب یهشدار گزارش م کیکه  یهنگام •

  .ضبط کنددرست حنه ا در صر ریتصو

 Upload  to  

FTP  

 ری فعالکه هشدا یمشخص هنگام FTP را به سرور یفور یبه طور خودکار عکس ها نیانتخاب شده، دورب Upload to FTPبا 

 .ارسال می کند شده است

  .دیکامل کرده ا عملکرد نیرا قبل از استفاده از ا Snapshot و FTP که دیحاصل کن نانیاطم

Recording  

 کند.  ی، به صورت خودکار ضبط متشخیص هشدارهنگام  نیانتخاب شده، دورب  Recordingبا 

کند که مدت زمان ضبط  یم مشخص  Post-Record(s).تنظیم کنید Storage را در صفحه  Post-Record (s)ابتدا لطفا

  .، همچنان ادامه داردهشدار انیپس از پا

 Alarm  the  
Center  

 .کند یارسال م یهشدار، اطلاعات هشدار را به سرور مرکز تشخیصهنگام  نیانتخاب شده، دورب Alarm the Centerبا 

 . دیرا کامل کن  Serverصفحه  یرو ماتیابتدا تنظ لطفا

Trigger 

Tracking  

 .کند یخودکار م یابیشروع به رد تشخیص هشدارهنگام  نیانتخاب شده، دورب  Trigger Trackingبا 

 .کنند یم یبانیرا پشت عملکرد نیا نیدورب یاز مدل ها یبرخ فقط

  .دیکن میتنظ  Smart Settingsخودکار را در صفحه  یابیاول رد لطفا

Trigger E-

mail  

را به آدرس ايميل مشخص  یفور  یهشدار، به طور خودکار عکس ها تشخیصهنگام  ی   ، دورب Trigger E-mailبا انتخاب 
 .کند  ارسال می

  .دیکرده ا  لیرا تکم E-Mail عملکرد نیکه قبل از استفاده از ا  د یحاصل کن اننیاطم

Enable Plan  

 دیتوان ی. شما مدیکن میحرکت موثر است تنظ صیتشخ هشدارکه  یزمان برایرا  انیشروع و پا یرا انتخاب کرده و زمانها گزینه

. دوره را ویرایش کنید در جدول یزمان یدوره ها Edit یوبر ر کیطرح و با کل کیرسم  یموس برا دنیکشبا  میبه طور مستق

 .کند یم شده گزارشآلارم ها را فقط در مدت زمان مشخص  نی. دوربدداشته باشن یتوانند همپوشان ینم یزمان یها

 .دیکن میهر روز تنظ یو چهار دوره برا دیانتخاب کن کشنبهیاز دوشنبه تا  دیتوان یم شما
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 زمان در جدول یدوره ها شیرایو           دیموس را بکشطرح،  کیرسم  یبرا 

 :توجه  

 یروز، م کی یبرنامه برا میشود. پس از تنظ یم یبانیپشت 8.0بعد از  IE یبا استفاده از ماوس تنها با نسخه ها یزیر برنامه

  .دیاعمال کن Pasteو  Copy یرو کیبا کل گرید یروزها یمشابه را برا ماتیتنظ دیتوان

7. Save . را بزنید 

 ای شبکه صیتشخ

 تنظیم کنید. Grid  را به حالت  Detection Mode و شویدSetup > Events > Motion Detection  وارد .1

 

 .تواند نامنظم باشد یدر شبکه م صی( تشخیمنطقه )ها .2

قابل  )هشدار یا خیر دگزارش دهکت را حر صیتشخ هشدار کی ایکه آ دیریبگ میتا تصم دیانتخاب کن نیدورب یرا برا صیتشخ تیحساس .3

 (.سازگار NVR مشاهده در

 .دیکن میهشدار را تنظ یپارامترها .4

⚫ Suppress Alarm(s) :  شود یشده گزارش نم نیی، هشدار مشابه در مدت زمان تعفعال شدن یک هشدارپس از. 

⚫ Clear Alarm(s) : .بعد از اینکه یک هشدار فعال شد 

 .تواند دوباره گزارش شود یم زینشود، هشدار پاک خواهد شد و هشدار ن فعالشده  نییمان تعاگر هشدار مشابه در مدت ز ❖

نشود، حذف نخواهد شد. سپس  یمنقض تعیین شدهکه زمان  یشده فعال شود، هشدار تا زمان نییاگر هشدار مشابه در مدت زمان تع ❖

 .تواند دوباره گزارش شود یمهشدار همان 

 هشداراز  پساقدامات  حاتیتوض ق،یمراحل دق یانجام شود. برا زمانی حرکت و برنامه صیتشخ هشدارتوسط  که دینک میرا تنظ لازم اقدامات .5

 .دینیحرکت را بب صیتشخ هشدار یکربندیدر پ

6. Save . را بزنید 

 تنظیم هشدار خرابکاری

 .دهد یمسدود شده است گزارش م ین مشخصدت زمام یکه لنز برا یزمان خرابکاری هشدار کی نیکه دورب یبه طور خرابکاری هشدار یکربندیپ

 
 دینیبب اتیجزئ یرا برا یشود. لطفا مدل واقع ینم یبانیاز مدل ها پشت یبرخ در عملکرد نیا ⚫

 .دینیوب را بب یواقع یرابط کاربر اتیممکن است با مدل ها متفاوت باشد. لطفا جزئ هشداراز  یاقدامات ناش ⚫

 

  

  

 توجه!       
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  Setup > Events > Common Alarm >Tampering Alarm  مراحل زیر را طی کنید : .1

  

2. On   یبرارا Tampering Alarm دیانتخاب کن. 

 .یا خیر درا گزارش ده خرابکاریهشدار  کی ایکه آ دیریبگ میتا تصم دیکن میتنظ نیدورب یو مدت زمان را برا صیتشخ تیحساس .3

 تیکه حساس یزماندر سطح متوسط،  تیبا حساس سهی. در مقانییسطح پاشود: سطح بالا، سطح متوسط و  یم میبه سه سطح تقس تیحساس

 یمدت مشخص یکه لنز برا یهنگام نیکند. دورب ییمکان دورتر را شناسا کیتواند مسدود کردن از  یم نیدوربشده است  میبه بالا تنظ

 .دهد یم گزارش مسدود شده، هشدار

 .دیرا پاک کن Tampering Alarm دیی، کادر تأهشدارکردن  الرفعیغ یاست. برا حساس شیبه کل صفحه نما خرابکاری هشدار

از  پساقدامات  حاتیتوض ق،یمراحل دق یبراشود.  زمانی انجام برنامهطبق  خرابکاری یها هشدارکه توسط  دیکن میرا تنظ لازم اقدامات .4

 .دینیحرکت را بب صیتشخ هشدار یکربندیدر پ هشدار

5. Save . را بزنید 

 صداتشخیص تنظیم هشدار 

که حجم  یهنگام ایشده  نییاز حد تع شیکاهش حجم ب ای شیکه افزا یکند. هنگام ییرا شناسا یورود یصوت یها گنالیتواند س یم نیدورب

 کیکه  دیحاصل کن نانیکند. اطم یم یرا راه انداز لازمدهد و اقدامات  یهشدار را گزارش م تشخیص کی نیرسد، دورب یبه آستانه م یورود

 .هشدار روشن است یورود یکربندیدر پ یصوت یمتصل شده است و ورود نیبه دورب یبه درست یصوت یودور گاهستد

 
 دینیبب اتیجزئ یرا برا یشود. لطفا مدل واقع ینم یبانیاز مدل ها پشت یبرخ در عملکرد نیا ⚫

 .دینیوب را بب یعواق یررابط کارب اتیممکن است با مدل ها متفاوت باشد. لطفا جزئ هشداراز  یاقدامات ناش ⚫

 

  

  .Setup > Events > Common Alarm >Audio Detection  مراحل زیر را طی کنید : .1

 توجه!       
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2. Enable  برای  راAudio Detection رفعالیغ ی. برادیکن میآستانه را تنظ ایو تفاوت  دیرا انتخاب کن صینوع تشخ کی،  دیانتخاب کن 

 .دیاک کنرا پ  Enableصدا، علامت کادر  صیکردن تشخ

 

  .دهد یمهم را شرح م یپارامترها یبرخ ریز جدول

 شرح  پارامتر

Detection Type  

⚫ Sudden Rise : می شودگزارش  هشداراست  مقدار مشخص شده بیشتر صدا از شیکه افزا یهنگام. 

⚫ Sudden Falls :می شودگزارش  هشداراست  مقدار مشخص شده بیشتر کاهش صدا ازکه  یهنگام. 

⚫ Sudden Change: می شودگزارش  هشداراست  شده بیشترمقدار مشخص  صدا از یا کاهش شیکه افزا یهنگام. 

⚫ Threshold :می شودگزارش  هشداراست  آستانه مشخص شده بیشتر صدا از میزانکه  یهنگام. 

Difference  

⚫ Threshold:  شود، هشدار  ینه تجاوز مآستا زا که یشود، زمان میبه عنوان آستانه تنظ میزان صدا کیپس از آنکه
  .شود یگزارش م

⚫ Difference: هشدار کی، رخ دهد از تفاوت شیب صدا کاهش ای شیکه افزا ی. هنگاممیزان صدادو  نیتفاوت ب 

 .می شودگزارش 

 توجه :

 .شود یحجم صدا استفاده م یریاندازه گ یبرا یصوت صیدر منطقه تشخ اسیمق ⚫

 صیتشخ هشدار دهنده فعال شدن . بخش قرمز نشانمی شودداده شده  نشان یبه طور لحظه اصدا  صیتشخ جیتان ⚫

 .استصدا 

   

Scale Volume 
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 شرح  پارامتر

 

 

 Difference   

  

 تحریک هشداراز  یاقدامات ناش حاتیتوض ق،یمراحل دق ی. برادیکن میتنظ ازیرا در صورت ن فعالیتهشدار و برنامه  تحریکاز  یاقدامات ناش .3

 .دیحرکت مشاهده کن صیتشخ هشدار یکربندیرا در پ

4. Save . را بزنید 

 تنظیم ورودی هشدار

، ابتدا باید اطلاعات مربوط به ورودی هشدار عملکرددوربین می تواند اطلاعات زنگ را از یک دستگاه شخص ثالث دریافت کند. برای استفاده از این 

 .ور معمول بسته شده( و زمان گزارش هشدارا به طرا پیکربندی کنید: پورت، نام هشدار، نوع هشدار )به طور معمول باز ی

 
 دینیبب اتیجزئ یرا برا یشود. لطفا مدل واقع ینم یبانیاز مدل ها پشت یبرخ در عملکرد نیا ⚫

 .دینیوب را بب یواقع یرابط کاربر اتیممکن است با مدل ها متفاوت باشد. لطفا جزئ هشداراز  یاقدامات ناش ⚫

 

  

  .Setup > Events > Common Alarm > Alarm Input زیر را طی کنید :مراحل  .1

  

 توجه!       
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 .کنید تنظیم را هشدار نام و کنید انتخاب را هشدار .2

با توجه به نوع دستگاه ورودی هشدار دهنده شخص ثالث. به عنوان مثال، اگر دستگاه ورودی هشدار دهنده شخص  N.C یا N.O انتخاب .3

انتخاب کنید. ، به طوری که دوربین می تواند اطلاعات زنگ را از دستگاه ورودی  اینجا دررا  N.O باشد، بایدثالث به طور معمول باز 

 .هشدار دهنده شخص ثالث دریافت کند

تحریک از  یاقدامات ناش حاتیتوض ق،یمراحل دق ی. برادیکن میتنظ ازیرا در صورت ن فعالیتو برنامه ورودی از هشدار  یاقدامات ناش .4

 .دیحرکت مشاهده کن صیتشخ ارهشد یکربندیرا در پ رهشدا

5. Save . را بزنید 

 تنظیم خروجی هشدار

تشخیص حرکت، دوربین می تواند اطلاعات هشدار را به دستگاه شخص ثالث خروجی اگر خروجی  هشدارخروجی هشدار توسط  فعال شدنپس از 

 .قابل تنظیم است هشدار ی. مدت زمان خروجال کندباشد ارسبه درستی به طور معمول باز و یا به طور معمول بسته شده تنظیم شده  هشدار

 
 پشتیبانی نمی شود. لطفا مدل واقعی را برای جزئیات ببینیداین عملکرد توسط بعضی از مدل ها 

 
 

   .Setup > Events > Common Alarm > Alarm Output  مراحل زیر را طی کنید : .1

  
 .یدکن تنظیم را هشدار نام و کنید انتخاب را هشدار .2

 .)تنظیم پیش فرض( و مدت زمان هشدار را تنظیم کنید N.O عیت را بهوض .3

تحریک از  یاقدامات ناش حاتیتوض ق،یمراحل دق ی. برادیکن میتنظ ازیرا در صورت ن فعالیتو برنامه ورودی از هشدار  یاقدامات ناش .4

 .دیحرکت مشاهده کن صیتشخ هشدار یکربندیرا در پ هشدار

5. Save . را بزنید 

 

 

 

 

 توجه!       
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 را در هنگام وصل شدن به دستگاه ها دنبال کنید: موارد زیربرای جلوگیری از آسیب رساندن به اجزای دوربین، به طور دقیق  

)تنظیم پیش فرض( تنظیم شده است، و دوربین و دستگاه خروجی هشدار خاموش شده   Normally Open. بررسی کنید که نوع هشدار به طور 1

 است.

را روشن کنید هشدارال، ابتدا دوربین را روشن کنید و سپس دستگاه خروجی ام اتص. بعد از اتم2

 

 ذخیره سازی کارت حافظه

 
 برخی از مدل ها پشتیبانی نمی شود و ممکن است با مدل ها متفاوت باشد. لطفا مدل واقعی را برای جزئیات ببینید در این عملکرد •

توصیه می شود. هنگامی که دوربین توسط سرور مدیریت  کارت حافظهیره سازی ند، ذخن در حالت مستقل عمل می کدوربی که هنگامی •

 جلوگیری کنید تا از تأثیر سرویس ضبط حافظه پنهان جلوگیری شود. کارت حافظهمرکزی اداره می شود، شما باید از ذخیره سازی 

 دوربین توسط پشتیبانی عدم صورت در پارامتر این. شود می دهدا نمایش  Post-Recordاگر دوربین قادر به استفاده از این قابلیت باشد،  •

 شود نمی داده نمایش

 

 تنظیم ذخیره سازی جانبی

برای ذخیره داده های ویدئویی و عکس های فوری به کارت حافظه به طور مستقیم استفاده می شود. هنگامی که دوربین در  جانبیذخیره سازی 

 .توصیه می شود جانبیسازی  می شود، ذخیره استفادهحالت مستقل 

 دستیذخیره سازی 

 .می کند تصاویر زنده را ضبطاگر ذخیره سازی دستی فعال باشد دوربین به طور مکرر 

1.  Setup > Storage > Storage .را کلیک کنید 

  

 .دهد می شرح را ممه هایپارامتر برخی زیر جدول. دهید تغییر نیاز مورد صورت به را تنظیمات و کنید شروع را جانبی سازی ذخیره .2

  شرح  پارامتر

Storage 

Medium  

 نوع منبع ذخیره سازی

  توجه :

   احتیاط !

 توجه!       
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کلیک کنید  Format ابتدا عملکرد ذخیره سازی کارت را غیرفعال کنید. سپس رویبرای فرمت کردن کارت حافظه،  ⚫ 

اره راه اندازی می تم دوبکلیک کنید. هنگامی که فرمت تکمیل می شود، سیس OK و سپس برای تأیید عملیات روی

 .شود

  .آزاد نمایش داده می شودفضای اطلاعات مربوط به فضای کلی و  ⚫

Data  

Overwrite  
Policy  

⚫ Overwrite : بازنویسی مکررا اگر فضای آزاد در کارت حافظه وجود نداشته باشد، داده های جدید داده های موجود را

 .می کنند

⚫ Stop :کارت حافظه ذخیره نمی شوند درود نداشته باشد، داده های جدید فظه وجاگر فضای آزاد در کارت حا. 

Post-Record(s)   ضبط پس از پایان هشدار ادامه یافتن هشدار، طول زمانبعد از فعال شدن برای ضبط. 

  

3. Save . را بزنید 

 

 برنامه ریزی ذخیره سازی

 .ذخیره می کند کارت حافظه دررا  تصاویرهای مشخص شده دوره  اگر ذخیره سازی برنامه ریزی شده فعال شود، دوربین در طول

 .شوید Setup > Storage > Storage  وارد .1

  

 .برای برخی از مدل های دوربین، صفحه به صورت زیر نمایش داده می شود
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2. Planned Storage کنید ظیمتن کند می ضبط حافظه کارت در را ویدیو دوربین که را هایی دوره سپس و کرده انتخاب را. 

3. Save . را بزنید  

 
 .کار نمیکند برنامه ریزی شده زمانی که ذخیره سازی دستی و ذخیره سازی برنامه ریزی شده هر دو فعال هستندذخیره سازی الف: 

 .را ببینید سازی جانبی در کارت حافظه، پخش ویدئو و دانلود ذخیره شدهضبط موارد برای خواندن ب: 

 

  

 ن ضبطه میزاتنظیم حافظ

ارت حافظه به عنوان یک منبع ذخیره پشتیبان از سرور مدیریت مرکزی استفاده کند. اگر ذخیره می تواند از ک مرکزییک دوربین تحت مدیریت 

دن بی ثبات متوقف شود، دوربین به طور خودکار شروع به ضبط کر ی سازی از دوربین به دستگاه ذخیره سازی مرکزی به علت اتصال به شبکه

 .کند کارت حافظه ذخیره می درافظه پنهان و فیلم ها را حدر

پشتیبان گیری ضبط فعال می شود، دوربین می تواند به طور خودکار ویدئو ذخیره شده در کارت حافظه را به یک منبع ذخیره سرور  هنگامیکه

 .دهد الانتقن ارتباط بین دوربین و سرور پشتیباپس از برقراری مجدد فایل  قالب یکپشتیبان در 

 
 :حافظه پنهان را برای یک دوربین تنظیم کنید، بررسی کنید درقبل از اینکه ضبط  ⚫

 .باشدکارت حافظه به درستی در دوربین نصب شده  ⚫

 .باشدمنبع پشتیبان در سرور مرکزی اضافه شده  ⚫

 .باشدمنبع پشتیبان برای دوربین اختصاص داده شده  ⚫

نمایش داده می شود. این پارامتر در صورت عدم پشتیبانی    Post-Recordلیت باشد، ین قاباگر دوربین قادر به استفاده از ا ⚫

 توسط دوربین نمایش داده نمی شود

 

  

  

 توجه!     

 توجه!     
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 غیر فعال کردن ذخیره سازی جانبی

 .شوید Setup > Storage > Storage  وارد .1

   
2. Storage Policy   راOff کنید. Post-Record تنظیم  سپس، نشان داده می شود این ویژگی است اده از، اگر دوربین قادر به استف

 .می شود

3. Save . را بزنید  

 تعمیر ونگهداری سیستم

 
 برخی از مدل ها پشتیبانی نمی شود . لطفا مدل واقعی را برای جزئیات ببینید در این عملکرد •

 

 

 امنیت

 مدیریت کاربران

 :دو نوع از کاربران در سیستم وجود دارد

⚫ Administratorعنوان : به "admin"  ،در این راهنما اشاره شده است. نام پیش فرض مدیرadmin  ت. است که قابل تغییر نیس 

Admin  کامل است و می تواند تمام کاربران و دستگاه ها را مدیریت کند. فقط یک کاربر دسترسیدارای admin در سیستم مجاز است. 

⚫ Common user :عنوان به کتابچه این در "user" و ضبط شده است. حداکثر  زنده تصاویر مجاز به پخش فقط. کاربر است شده ارهاش

 .ستندکاربر در سیستم مجاز ه 32

 .( اضافه کنیدSetup > Security > Userکاربری )در قسمت  مدیریت شما می توانید یک کاربر را در رابط

 .جدید، رمز عبور را تغییر دهید یا کاربر را با پاک کردن نام کاربری حذف کنید زرمردن پس از اینکه کاربر با موفقیت اضافه شد، می توانید با وارد ک

 
سیستم است، کاربر  درونفقط مدیر می تواند کلمات عبور را تغییر دهد. تغییر نام کاربری یا رمز عبور برای کاربر زمانی که کاربر هنوز  ⚫

 .ورود به سیستم از نام کاربری یا رمز عبور جدید استفاده کند د برایرا مجبور به خروج از سیستم خواهد کرد. کاربر بای

سیستم است، کاربر را مجبور به خروج از سیستم  درونمی تواند کاربران را اضافه و حذف کند. حذف کاربر هنگامی که کاربر هنوز  فقط مدیر ⚫

 خواهد کرد. یک کاربر حذف شده نمیتواند وارد سیستم شوید

⚫  

 ایمن ل دادهتنظیم انتقا
 .تنظیم کنیدیک کانال امن برای انتقال داده ها برای اطمینان از امنیت 

  

  

 توجه!     

 توجه!     
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 .برخی از مدل ها پشتیبانی نمی شود . لطفا مدل واقعی را برای جزئیات ببینید در این عملکرد •

 

 .شوید Setup > Network > Port  وارد .1

  

 .وارد کنید HTTPS Port متن کادر در را پورت شماره .2

 کلیک کنید Saveروی  .3

 .کلیک کنید Setup > Security > Network Security > HTTPSروی  .4

  

5. On  را برای HTTPS انتخاب کنید. شما می توانید گواهینامه SSL سفارشی را در صورت نیاز وارد کنید. 

 کلیک کنید Saveروی  .6

وارد کنید، برای   https://IP:HTTPS port numberرمت ف ا دردفعه بعد که وارد سیستم شوید، برای ورود به حالت کانال امن آدرس ر .7

 .کنید وارد https: // IP استفاده می کنید،  HTTPS . اگر از پورت پیش فرض  https://192.168.1.13:443مثال، 

 احراز هویت

RTSP  ،پروتکل جریان واقعی( یک لایه پروتکل کاربردی است. برای انتقال و کنترل صدا و ویدئو(RTSP authentication   را روی رابط وب

 .تنظیم کنید

 .شوید Setup > Security > Network Security > Authentication  وارد .1

     

 .کلیک کنید Saveرا انتخاب کنید و سپس روی   authentication mode حالت .2

 مخفی کردن اطلاعات فروشنده

 .دیرا در رابط وب پنهان کن شبکه نیاطلاعات مربوط به فروشنده دورب دیتوان یشما م

1. Setup > Security > Registration Info .را انتخاب کنید 

  

 را انتخاب کنید. Registration Info, On در زیر  .2

 کلیک کنید Saveروی  .3

  ARP حفاظت

 گریشبکه د کیبتواند از  یروتیامپک نکهیقبل از ا دیبا MAC و آدرس  gatewayکند.  یمحافظت م ARP از حملاترا  نیدورب کی عملکرد نیا

توانند  یدر همان شبکه م یشخص یها انهیشده باشد، تنها را مینادرست تنظ MAC کیشود. اگر  میداشته باشد، درست تنظ یدسترس نیبه دورب

 .باشند تهداش یدسترس

1. Setup > Security > Network Security > ARP Protection.  .را انتخاب کنید 

 توجه!       
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 .دیکن میرا تنظ gateway MAC addressانتخاب کرده و  ARP محافظتیفعال کردن عملکرد  یرا برا ربوطهگزینه م .2

 .دیکن کیکل Save یرو .3

 IP آدرس لتریف
 .کندتعیین را ی مشخص IP از آدرس یدسترس عدم ای یتا دسترس دیاستفاده کن IP کردن آدرس لتریاز ف

 
 .ود . لطفا مدل واقعی را برای جزئیات ببینیدنمی ش برخی از مدل ها پشتیبانی در این عملکرد •

 
1. Setup > Security > Network Security > IP Address Filtering . را انتخاب کنید 

  
2. On   آدرس لتریفعال کردن ف یبرارا IP دیانتخاب کن. 

 .دی)ها( را اضافه کن IP و سپس آدرس دیرا انتخاب کن نگیلتریحالت ف کی .3

 دیکن کیکل Save یرو .4

 
                          مجاز است.  نیبه دورب یدسترس ی)ها( اضافه شده برا IP شده باشد، فقط آدرس میتنظ Whitelist یبرا  Filtering Modeاگر  •

 .تسین نیبه دورب ی)ها( اضافه شده مجاز به دسترس IP شده باشد، تنها آدرس میتنظ Deny Access یبرا  Filtering Modeاگر 

 .بار اضافه کرد کیتوان تنها  یرا م IP مجاز است. هر آدرس IP آدرس 32تا  •

توانند اضافه  یهستند و نم غیرمجاز ریز IP یمثال، آدرس ها ی. براباشد 0تواند  یباشد و چهارم نم 223-1 دیبا IP اول هر آدرس تیبا •

 224.0.0.1، 255.255.255.255، 127.0.0.1، 0.0.0.0شوند: 

 . 

 یدسترس استیس

 
صفحه ظاهر خواهد شد و از شما  کی د،یشو ستمیوارد س فیرمز عبور ضع کیگذارد. اگر شما آن را خاموش کرده و با  یم ریفعال کردن رمز عبور دوستانه بر استفاده تاث

 .به عنوان ضعف در نظر گرفته شده استفرض  شیصفحه وجود ندارد. رمز عبور پ نیدر ا Close ای Cancel دکمه چی. هدیده رییتا رمز عبور را تغ می خواهد

 

1. Setup > Security > Network Security > Access Policy .را انتخاب کنید 

  

  

  

  

 توجه!     

 توجه!     

 توجه!     
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 .دیکن کلیک  Onنهیگز ی، بر رو MAC Authenticationو   friendly passwordفعال کردن  یبرا .2

 .دیکن کیکل Save یرو .3

Watermark  

 .دیکن یرمزگذار یویدیرا با و یتا اطلاعات سفارش دیاستفاده کن  watermarkاز  جاز،رمیغ رییتغ ایاز حذف  یریجلوگ یبرا

 
 برخی از مدل ها پشتیبانی نمی شود .  در این عملکرد •

 

1. Setup > Security > Watermark . را انتخاب کنید 

  
2. On  را برایWatermark  یو سپس محتوا دیفعال کن Watermark دیرا وارد کن. 

 .دیکن کیکل Save یرو .3

 تنظیم ساعت سیستم 
 .دیخود استفاده کن ستمیزمان س میتنظ یبرا ریز یاز روش ها دیتوان یشما م

 ستمیزمان س یهمگام ساز ای یدست میتنظ

 کلیک کنید. Time شده و سپس روی صفحه Setup > Common > Time وارد  .1

   

2. synchronization mode دیرا انتخاب کن. 

 ماتیتنظ یهمگام ساز یرا برا  Sync with Computer Time دیتوان یم نی. شما همچندیکن میرا تنظ ستمیمان سو ز ینزما منطقه .3

 .دیکن کیخود کل وتریخود با کامپ نیزمان دورب

 .دیکن کیکل Save یرو .4

 NTP با سرور یهمگام ساز

 کلیک کنید . Time شده و روی صفحه Setup > Common > Time وارد  .1

  

2. Sync Mode  را به Sync with NTP Server آدرس می، و سپس تنظیمتنظ IP و پورت سرور NTP ی راانجام دهیدو فاصله به روز رسان. 

 توجه!       
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 کند. یم یهمگام ساز NTPبا سرور  یبه صورت دوره ا یندورب دیکن کیکل Save یرو .3

 DST میتنظ

  انتخاب کنید.را  DST شده و صفحه Setup > Common > Time وارد  .1

  
 .دیکن میرا تنظ  DSTتغییرو  ان،یزمان شروع، زمان پا د،یانتخاب کن DST یبرارا  On نهیگز .2

 .دیکن کیکل Save یرو .3

 تنظیم سرورها

 سرور هوشمند
 .دیکن یکربندیسرور هوشمند را پ دیشود، با تیریمد یسرور مرکز کیفوق العاده حساس توسط  نیدورب کیاگر 

 
 .کند یم یبانیرور هوشمند پشتاز س نیدورب یاز مدل ها یفقط برخ ⚫

 .دیکن یکربندیود پشآپلود ای  یفور ریتصاوچه  برای اینکه TMS سرور دیچهره، شما با یاستفاده از عکس فور یبرا ⚫

 

  

 کنید.کلیک  Intelligent Server شده و روی صفحه Setup > Common > Server وارد  .1

  
 .دیکن لیرا تکم اتمیتنظ ریو سا دیکن میرا تنظ TMS سرور IP آدرس .2

 .دیکن کیکل Save یرو .3

 تنظیم حالت پورت سریال
با دستگاه شخص ثالث  دیبا نیدر دورب الیپورت سر ماتیشود. تنظ یتبادل اطلاعات با دستگاه شخص ثالث استفاده م یبرا RS485 الیپورت سر

 .متصل سازگار باشد

 
  .ا مدل واقعی را برای جزئیات ببینید. لطف برخی از مدل ها پشتیبانی نمی شود در این عملکرد •

 

  PTZکنترل  

 ارسال دستورات کنترل با .دیکن میتنظ  PTZ Controlرا به  Port Mode دیدستگاه شخص ثالث، با قیاز طر PTZ نیدورب کیکنترل  یبرا

PTZ مطابق با PELCO-D پورت قیاز طر RS485نیدورب دیتوان ی، م PTZ  پنلکنترل را بدون استفاده از PTZ دیکنترل کن. 

 را انتخاب کنید . Serial Port شده و صفحه Setup > System > Ports & Devices وارد  .1

  

Server IP 

Server Port 

Device No . 

  

  

 توجه!     

 توجه!     
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2. PTZ Control  ییکشو ستیرا از ل Port Mode دهد یمهم را شرح م یپارامترها یبرخ ری. جدول زدیانتخاب کن. 

  شرح  پارامتر

PTZ Protocol  

 .دنکن یم یبانیپشت اه انالکه ک PTZ پروتکل میتنظ

 :توجه

 .شده باشد میتنظ  PTZ Controlبه  Port Mode که دیکن میتنظ یپارامتر را فقط زمان نیا دیتوان یشما م ⚫

تواند بدون استفاده از پورت  یم نیشود، دورب یم میتنظ INTERNAL-PTZ یبر رو  PTZ Protocolکه  یهنگام ⚫

به اتصال  ازیمورد، شما فقط ن نی(. در ایخاکستر ی سریالپورت ها یترهامتصل شود )پارام یخارج PTZ به الیسر

 .دیاستفاده کن یداخل PTZ مانند را PTZ دیتوان یبه لنز، و سپس شما م نیزوم و فوکوس از دورب

PTZ Mode  

⚫ Built-in PTZ Priority: کند کنترل یم یابتدا سع نیشود، دورب یانتخاب م نهیگز نیکه ا یهنگام PTZ وان )به عن

که  یاتیعمل یانجام دهد. برا یخارج PTZ قیطرکه از آن یبه جاانجام دهدرا خود ( فوکوس ای ییبزرگنما یمثال برا
 .کند یاستفاده م یخارج PTZ از نیانجام دهد، دورب ییتواند به تنها ینم نیدورب

⚫ External PTZ Priority : کند یم یابتدا سع نیدورب PTZ نترل کندک الیرپورت س قیرا از طر. 

 توجه :

 .شده باشد میتنظ  PTZ Controlبه  Port Mode که دیکن میتنظ یپارامتر را فقط زمان نیا دیتوان یشما م ⚫

است و  تظیم  Built-in PTZ Priorityبه  شهیپارامتر هم نیانتخاب شده است، ا INTERNAL-PTZ که یهنگام ⚫

که  یزمان یحت یخارج PTZ قی. کنترل از طرستین الیورت سرپ قیاز طر یخارج PTZ به نیبه اتصال دورب یازین

 .ستیمتصل است موثر ن یخارج PTZ به نیدورب

وصل  یبه درست PTZ مربوط به کنترل یکه رابط ها دیحاصل کن نانی. اطمدیکن میتنظ ازین با توجه بهپارامتر را  نیا ⚫

 .شده اند

Address Code  

 .دیکن میرا تنظ PTZ یکد آدرس برا

 :جهتو

 PTZشده است و  میتنظ  PTZ Controlبه  Port Mode که دیکن میتنظ یپارامتر را فقط زمان نیا دیتوان یم اشم

Protocol  یبرا  INTERNAL-PTZنشده است میتنظ. 

  

 .دیکن کیکل Save یرو .3



 

62 

  Transparent کانال

به انتقال  دنیرس ی. کانال شفاف به طور عمده براکنید ستفادها ثالثبه انتقال داده شفاف با دستگاه شخص  یابیدست یبرا RS485 الیاز پورت سر

 .شود یدو دستگاه استفاده م نیاطلاعات شفاف ب

 
 .دینیبب اتیجزئ یرا برا یشود. لطفا مدل واقع ینم یبانیاز مدل ها پشت یعملکرد توسط بعض نیا ⚫

 .دیکرده ا مید تنظخو نیبدور یبرا Trans-Channel را به  Port Modeکه  دیحاصل کن نانیاطم ⚫

 

 را انتخاب کنید. Serial Port شده و صفحه Setup > System > Ports & Devices وارد  .1

  
2. Trans-Channel ییکشو ستیرا از ل Port Mode دیانتخاب کن. 

3. Enable  برای  راTrans-Channel دیانتخاب کن . 

 (.ورت که کانال شفاف به آن متصل استماره پو ش IP آدرس) دیمقصد و شماره پورت را وارد کن IP آدرس .4

 .دیکن کیکل Save یرو .5

OSD  

 .دیرا به عنوان حالت پورت انتخاب کن OSD دی، شما باOSD اطلاعات از دستگاه شخص ثالث در شینما یبرا

 کند و سپس آن را در یمه مرا ترجشده  افتیکند، اطلاعات در یم افتیدر RS485 الیپورت سر قیاطلاعات از دستگاه شخص ثالث را از طر نیدورب

OSD  دهد یم شینما. 

 
که اطلاعات ارسال  دیحاصل کن نانیشده از دستگاه شخص ثالث، اطم افتیاطلاعات در درست جهت ترجمه نیفعال کردن دورب یبرا

با  شتر،یب اتیئجز یراشده توسط شرکت ما است. ب نییمطابق با فرمت داده تع الیپورت سر قیشده توسط دستگاه شخص ثالث از طر

 .دیریفروشنده خود تماس بگ

 

  

 را انتخاب کنید. Serial Port شده و صفحه Setup > System > Ports & Devices د وار .1

  

  

 توجه!     

 توجه!     
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2. OSD ییکشو ستیرا از ل Port Mode دیانتخاب کن .Enable OSD Report اطلاعات نیبنابرا) دیرا انتخاب کن OSD  به پلتفرم آپلود

 (.شود یم

 .دیکن کیکل Save یور .3

ONVIF Transparent Channel  

 .دستگاه شخص ثالث کیو  نیدورب RS485 پورت نیب (ONVIF) کانال شفاف قیانتقال اطلاعات از طر

 را انتخاب کنید. Serial Port شده و صفحه  Setup > System > Ports & Devices وارد  .1

  

2. Port Mode  روی را Select Trans-Channel via ONVIF کنید. میتنظ 

 .دیکن کیکل Save یرو .3

 کنترل برف پاک کن

 .دیکن میپاک کن را تنظبرف  یپارامترها باید د،یرا کنترل کن برف پاک کن دیبتوان نکهیقبل از ا

 
 .دینیبب اتیجزئ یرا برا یشود. لطفا مدل واقع ینم یبانیاز مدل ها پشت یعملکرد توسط بعض نیا ⚫

 

 کلیک کنید. External Device شده و روی صفحه Setup > System > Ports & Devices وارد  .1

  

 توجه!       
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 .دهد یمهم را شرح م یپارامترها یبرخ ریپاک کن. جدول ز برف یحالت کنترل برا میتنظ .2

  شرح  پارامتر

Serial Port  
شود.  میتنظ PELCO-D به دیبا PTZ پروتکل نیشود. بنابرا یکنترل م PELCO-D پاک کن بر اساس دستورالعملبرف 

 .دیمشاهده کن شتریب اتیجزئ یرا برا PTZ کنترل

Alarm  

Input/Output  دیاستفاده کن کنپاک برف بستن مدار و کنترل  ایباز کردن  یهشدار برا یو خروج یز ورودا. 

  

 مشاهده وضعیت دستگاه

 .دیخود را مشاهده کن نیدورب یفعل تیوضع دیتوان یشما م

1. Setup > Common > Basic Info . را انتخاب کنید 

  
 .دیکن کیکل را  Refreshتیوضع نیاطلاعات آخر یبرا .2

 .دیدستگاه را مشاهده کن اطلاعات .3

 
 .دیمشاهده کن هیرا در صفحه اطلاعات اول رهیسرور هوشمند و غ تیعامل، وضع ستمیمدل دستگاه، نسخه س دیتوان یشما م

 

 وضعیت ذخیره عکس

 .دیکامل مشاهده کن یساز رهیذخ استیس یکارت حافظه را برا یساز رهی. ذخدیا مشاهده کنعکس ر یساز رهیذخ یفعل تیوضع

 
 دینیبب اتیجزئ یرا برا یکنند. لطفا مدل واقع یم یبانیعملکرد را پشت نیا یساز رهیبا عملکرد ذخ ییفقط مدل ها 

 

  

1. Photo .را انتخاب کنید 

IPC 

IPC 

A 

V 1 . 0 

2102335 CC 3531740100232 

192 . 168 . 1 . 13 / 255 . 255 . 255 . 0 / 192 . 168 . 1 . 1 

48 : ea : 63 : 4 d : 56 : 88 

2018 / 1 / 25 
  19 : 16 : 27 

0 
  Day ( s ) 

  0   Hour ( s ) 
  0   Minute ( s ) 

Offline 

  

  

 توجه!     

 توجه!     
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 .دیکن کیکل Refresh یبر رو ،یساز رهیذخ تیوضع یبه روز رسان یبرا .2

 .دیحذف کن ای خروجی بگیرید  Image Listعکس ها را در منطقه  دیتوان یم شما .3

 به روزرسانی دستگاه

شود که  یم هیتوص د،یارتقا ده یدستگاه ها را در حالت دسته ا دیخواه یشود و شما م یم تیریمد یمرکز تیریاگر دستگاه توسط سرور مد

 .دیمراجعه کن یمرکز تیریسرور مد یکاربر برا یبه راهنما ق،یمراحل دق یانجام شود. برا یکزرور مرارتقاء در س اتیعمل

 شوید . Setup > System > Maintenance  وارد .1

  
 .دیدرست را انتخاب کن به روزرسانی لیو فا دیکن کیکل Browse یرو Software Upgrade قسمت در .2

خواهد  یبه طور خودکار دوباره راه انداز نی، دورببه روزرسانی. بعد از اتمام دیکن دییأشروع ت یو سپس برا دیکن کیکل  Upgrade یرو .3

 .دیرا انتخاب کن Upgrade Boot Programارتقاء،  یکنند. برا یم یبانیبرنامه بوت پشت به روزرسانیاز دستگاه ها از  یشد. برخ

 .دیکن کیکل Detect ی، رویابر ارتقاء یدر دسترس برا دیجد ینسخه ها صیتشخ یممکن است برا شما .4

 

 

 

 

 

  



 

66 

 
 

 .شما باید از فایل ارتقا درست برای دوربین خود استفاده کنید. در غیر این صورت، نتایج غیر منتظره ممکن است رخ دهد •

 .باشداست و باید تمام فایلهای لازم را داشته  ZIP فایل ارتقا یک فایل •

ستم شروع به کار می کند. عملکرد برنامه ارتقاء بوت به طور پیش فرض غیر فعال شده سپس سیو را بارگذاری برنامه بوت سیستم عامل  •

است و فقط دوربین به آخرین نسخه ارتقا خواهد یافت. اگر فعال باشد، دوربین و برنامه بوت هر دو ارتقا می یابند و سیستم عامل نسخه 

 .ی می توان ارتقا داده راحترا می توان به درستی بوت کرده و دوربین را بهای زیر 

 .اطمینان حاصل کنید که منبع تغذیه در هنگام ارتقاء نرمال باشد. دستگاه پس از ارتقا کامل، راه اندازی مجدد خواهد شد •

 

 راه اندازی مجدد سیستم
 .شوید  Setup > System > Maintenanceوارد  .1

 

 

 

 پس از تأیید عملیات، دوباره راه اندازی خواهد شد دستگاهکلیک کنید.  Restart، روی   Device Restartدر قسمت  .2

 
 .این عمل را با احتیاط انجام دهید زیرا سیستم راه اندازی مجدد سیستم را خاتمه می دهد

 

 سیستم وارد کردن و خارج کردن فایل پیکربندی

رجی ذخیره کنید. شما همچنین می توانید تنظیمات را با ازی خاذخیره س دستگاهرایانه یا یک  درکرده و آنها را  خارجتنظیمات فعلی دوربین را 

 .ذخیره سازی خارجی به دوربین بازگردانید دستگاهوارد کردن تنظیمات پشتیبان ذخیره شده روی کامپیوتر یا یک 

 
رمز ورود به سیستم مدیر  د زیر:، تمام تنظیمات به پیش فرض های کارخانه بازگردانده می شوند، به جز موار  Defaultانجام عملیاتپس از  •

 سیستم، تنظیمات شبکه و زمان سیستم.

 ممکن است رخ دهد. اطمینان حاصل کنید که فایل پیکربندی صحیح را برای دوربین خود وارد کنید. در غیر این صورت، نتایج غیر منتظره •

 .می شودهنگامی که فایل پیکربندی با موفقیت وارد می شود دوربین دوباره راه اندازی  •

 
 

 شوید . Setup > System > Maintenance  وارد .1

  

کلیک کنید و تنظیمات مورد نظر را برای وارد   Importدر کنار دکمه   Browseردن پیکربندی هایی که پشتیبان گرفته اید، بر روی ک وارد برای .2

 .کلیک کنید. نتیجه نمایش داده خواهد شد Importکردن انتخاب کنید و سپس روی 

 Export ( کلیک کنید، مقصد را تعیین کنید و سپس رویExporting)در کنار فیلد   Browseتنظیمات سیستم فعلی، روی  خروجی گرفتن ازبرای  .3

 .کلیک کنید

  

  

   احتیاط !

 توجه!     

 توجه!     
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 فرض پیش تنظیمات و مجدد اندازی راه دستگاه. کنید تأیید را عملیات سپس و کنید کلیک  Default روی فرض، پیش تنظیمات زگرداندنبا برای .4

 .تگاه را به تنظیمات پیش فرض کارخانه بازگردانددس کامل طور به گزینه انتخاب با  Default روی بر کلیک با. کند می بازیابی ار

 اطلاعات تشخیصیجمع آوری 

 .کنید منتقلمربوط و تنظیمات سیستم است. شما می توانید اطلاعات تشخیص را به کامپیوتر خود  ثبت وقایعاطلاعات تشخیص شامل 

1. Setup > System > Maintenance . را انتخاب کنید 

  

 .کلیک کنید Export سپس رویکلیک کنید تا مقصد را تعیین کنید و  Browse روی بر ،  Diagnosis Info بخش در .2

 
     انندبزار ممی شود. شما باید فایل را با استفاده از یک ا منتقلاطلاعات تشخیص به صورت یک فایل فشرده به پوشه محلی  •

WinRAR   کرده و سپس فایل را با استفاده از یک ویرایشگر متن باز کنید آزاد فشردهاز حالت. 

می توانید ویدیو را با اطلاعات اشکال زدایی همزمان نمایش دهید، که این امر ،  Collect Image Debugging Infoبا انتخاب  •

 .باعث ساده تر شدن عیب یابی می شود

 فوکوس تنظیمات
شود  یم هی، توص اءیاش واضح عکسبرداریکند. به منظور  میتواند سرعت فوکوس خودکار را با توجه به حداقل فاصله فوکوس تنظ یدستگاه م نیا

 3اصله در ف ءایاش در نتیجهباشد،  متر 3، به عنوان مثال، اگر حداقل فاصله فوکوس باشدو لنز  اءیاش نیکه حداقل فاصله فوکوس کوتاه تر از فاصله ب

 . خواهند بود خارج از فوکوس ،لنزاز  متری 

 
 .دیمشاهده کن اتیجزئ یرا برا یشود. مدل واقع یم یبانیپشت auto-focus با ییتنها توسط دستگاه ها عملکرد نیا

 
1. Setup > System > Maintenance   کنید.را انتخاب 

  

 .دیکن یکربندیرا پ Max. Zoom Ratio( و متر یت)واحد: سان  Focus  ،Min. Focus Distance ریدر ز .2

 .دیکن کیکل OK یرو .3

 ارتفاع نصب دستگاه

 .کند میبتواند لامپ مادون قرمز خود را به طور خودکار تنظ دوربینتا  دیوارد کن نیمادون قرمز نصب شده به زم دوربینرا از  یارتفاع واقع

 
 .دینیبب اتیجزئ یرا برا یشود. لطفا مدل واقع یم یبانیپشتقرمز  مادون یها نیاز دورب یعملکرد فقط توسط برخ نیا
 
1. Setup > System > Maintenance .را انتخاب کنید 

 

  

  

  

  

 توجه!     

 توجه!     

 توجه!     
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 .دیوارد کن نیمادون قرمز نصب شده به زم وربیندرا از  یارتفاع واقع .2

 دیکن کیکل OK یرو .3

  Fisheyeپارامتر دوربین 

 .دیکن میرا تنظ  fisheye یپارامترها ،یبا توجه به حالت نصب واقع یدرستبه  دیشما با ،یبه درست دئویو شینما یبرا

 
 .دینیبب اتیجزئ یرا برا یشود. لطفا مدل واقع یم یبانیپشت  fisheye ینهایفقط توسط دورب عملکرد نیا

 

  

 .سازگار باشد یب واقعالت نصبا ح دی. حالت نصب انتخاب شده بادی. حالت نصب را انتخاب کندیکن کیکلLive View > Mount  یرو .1

 

 .شود یداده م شینما ریصفحه به صورت ز ن،یدورب یاز مدل ها یبرخ یبرا

 

  

  

  

 توجه!     
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 .دهد یمهم را شرح م یپارامترها یبرخ ریجدول ز کنید. میتنظرا  پارامترها .2

  شرح  پارامتر

 

  

  

  

  

  

  

 

 

  

  

 :شیحالت صفحه نما ازدهی

 یاصل ریصوت •

 کیپانورام •

 3PTZ  + میکپانورا •

 4PTZ+  کیپانورام •

 8PTZپانورامیک +  •

 1PTZ+  کیپانورام 360° •

 کیپانورام 180° •

• Fisheye + 3PTZ 

• Fisheye + 4PTZ 

 6PTZ+  کیپانورام 360° •

• Fisheye + 8PTZ  

  

  

  

 :سه حالت نصب

 سقف •

 وارید •

 روی سطح زمین یا میز  •

 :توجه

  .زگار باشدسا یقعبا حالت نصب وا دینصب انتخاب شده با حالت

 

 

 مایش زندهن  4

 .رابط وب است قیپنجره از طر کیدر  نیدورب کیشده از  افتی( دریدر زمان واقع یریو تصو ی)صوتاویر تصپخش زنده  یزنده به معن شینما

 یشود. شما م یاهر مفرض ظ شیبه طور پ ندهز نمایش پنجره د،یشو ستمیکه وارد س یوقت د،یشو ستمیوارد س Live View کادر انتخاببا  اگر

 .دیخارج شو ایحالت تمام صفحه وارد  بهتا  دیکن کیپنجره دوبار کل یبر رو دیتوان
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 نوار ابزار نمایش زنده

 
 .دینیبکند، رابط وب را ب یم یبانیشما را پشت نیکه دورب یاتیعمل یمتفاوت باشد. برا نیتواند با مدل دورب یم شده یبانیزنده پشت شینما اتیعمل 

 

  شرح  دکمه

  
 زنده نمایشپخش / توقف 

  
 .دیکن میتنظ وتریکامپ یرا روپخش  یخروج یصدا زانیم

  

 میتنظ وتریکامپ یرا بر رو کروفونیصدا م زانیم ن،یو دورب وتریکامپ نیب یارتباط صوت یدر طول برقرار

 .دیکن

   

 .دیریگب وتریداده شده در کامپ شینما یفعل ریاز تصو یعکس فور کی

 .شده است میتنظ System Configurationدر  یفور یعکس ها رهیذخ ریمس

  

 یشروع / توقف ضبط محل

  .شده است میتنظ System Configurationدر  یضبط محل یساز رهیذخ ریمس

  
 .نیو دورب وتریکامپ نیب یشروع / توقف ارتباط صوت

  
 .دیمراجعه کن تالیجیبه استفاده از زوم د تر،شیات باطلاع یبرا .تالیجیشروع / توقف زوم د

  
 مراجعه کنید. منطقه فوکوساستفاده از  به شتر،یب اتیجزئ یبرا .منطقهفوکوس شروع / توقف 

  

 بعدی مراجعه3یابی  تیبه استفاده از موقع شتر،یب اتیجزئ یبرا بعدی.3یابی  تیشروع / توقف موقع

 .دیکن

  
 PTZ    ل پنلن کنتر/ پنهان کرد شینما

  

، 16: 9حالت واقعی با وضوح بالا در ریتصاو شینما یمثال، برا یدر پنجره. برا ریتصو شینسبت نما میتنظ

Scale بر اساس اندازه پنجره،  شینما یبرا د؛یرا انتخاب کنStretch با  شینما ی. برادیرا انتخاب کن

 .دیرا انتخاب کن Original ،یاصل ریاندازه تصو

/ 

/ 

/ 

/ 

/ 

/ 

 توجه!       
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  شرح  دکمه

  

 .دیتلفات بسته را به صفر بازگردان زانیم

 :توجه

  .شود ینوار ابزار شناور ظاهر م یدکمه بر رو نیزنده، ا شیپنجره نما یاز حرکت ماوس رو پس

  

 .پنجره نییدر پا ریت تیبسته و اطلاعات ب لفاتتنرخ  شینما

 :توجه

 .شود ینوار ابزار شناور ظاهر م یبر رو دکمه نیزنده، ا شیپنجره نما یاز حرکت ماوس رو پس

 گر،ید کیکل کی. با دیکن کیدکمه کل نیا یداده شود، بر رو شینما شهیکه اطلاعات هم نیا یبرا

قرار  نییآن را در پا ای دیپنجره قرار ده یماوس را رو نشانگرشود که  یظاهر م یاطلاعات فقط زمان

دیگر کند، اطلاعات  رکرا ت پنجره ایقرار داشته باشد پنجره در  هیثان 3. اگر نشانگر ماوس در حدود دیده

  شوند. نشان داده نمی

  
 .دیکن کیدکمه کل نیا یرو ریتصو ماتیباز کردن صفحه تنظ یبرا

  
 .در حالت تمام صفحه شینما

  

  

  

را انتخاب  سوم انیجر ایثانویه  انیجر ،یاصل انی: جرکندیم یبانیپشت نیزنده که دورب ییویدیو انیجر کی

 .دیکن

  

 مشاهده منطقه خاصی از تصاویر

. زوم دیکن افتیدر ریاز تصاو یاز بخش خاص یشتریدهد اطلاعات ب یم را امکان این به شمابعدی  3یابی  تیمنطقه و موقع فوکوس تال،یجیزوم د

 .بزرگ می کند افت کیفیتبدون را  ریتصو بعدی 3ییاب تیکه موقع ی، در حالبزرگ می کند ریتصو تیفیبا از دست دادن ک را ریتصو کی تالیجید

 تفاده از زوم دیجیتالاس

 
کند، رابط وب  یم یبانیپشتشما  نیکه دورب هایی اتیعمل یمتفاوت باشد. برا نیتواند با مدل دورب یمزنده  شینما اتیعمل از یبانیپشت

  .دینیرا بب

 

 ید .ب کنانتخا را از نوار ابزار  ، Live Viewبر روی صفحه   .1

  

      

 توجه!     
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 .(رسم کنید لیمستط کی) بکشید نییو سپس از بالا به پا دیو نگه دار دیکن کیدکمه ماوس را کل منطقه کیمشخص کردن  یبرا .2

 .بزنید موس را کیراست کل ر،یتصو گرید یدر قسمت ها ییو بزرگنما یاصل ریبازگرداندن اندازه تصو یبرا

 .دیکن کیکل       یخروج، رو یبرا .3

 از منطقه فوکوستفاده سا

 
کند، رابط وب  یم یبانیپشتشما  نیکه دورب هایی اتیعمل یمتفاوت باشد. برا نیتواند با مدل دورب یمزنده  شینما اتیعمل از یبانیپشت

  .دینیرا بب

 

  .دیکن کینوار ابزار کلدر   یرو  Live View در صفحه .1

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 .(دیکن رسم لیمستط کی) بکشید نییو سپس از بالا به پا دیو نگه دار دیکن کیرا کلماوس  دکمه منطقه کیمشخص کردن  یبرا .2

  

 توجه!       
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 .دیکن کیکل  یخروج، رو یبرا .3

 بعدی 3موقعیت یابی استفاده از 

 
 یاست. لطفا مدل ها PTZ مجهز به لنز زوم وشبکه  تحت صنعتی یها نیشبکه و دوربتحت  PTZ یها نیدورب یتنها برا عملکرد نیا

 دینیبب اتیجزئ یرا برا یواقع

 

 .دیکن کینوار ابزار کلدر    یرو Live View در صفحه .1

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 .(دیکن رسم لیمستط کی) بکشید نییو سپس از بالا به پا دیو نگه دار دیکن کیدکمه ماوس را کل منطقه کیمشخص کردن  یبرا .2

 .ددبرمیگربالا( زوم  به نیی)از پا با انجام حرکت برعکس

 .دیکن کیکل  یخروج، رو یابر .3

  Fisheye هاینمایش زنده از دوربین 

 
 .دینیبب اتیجزئ یرا برا یواقع یشود. لطفا مدل ها یم یبانیشبکه پشت تحتfisheye  یها نیتنها توسط دورب عملکرد نیا ⚫

  دوربین یپارامترها) Fisheye یترهاپارام متفاوت باشد. لطفا نیدورب یبرا fisheye ماتیدر وب ممکن است با تنظ شینما شیپ ریتصو ⚫

Fisheyeنیدورب و حالت (را ببینید  Fisheye دیکن میتنظ زنده شیقبل از شروع نما را. 

 

به  ریمختلف نصب، تصاو یدر حالت ها. PTZ و PTZ ،Panoramic و Fisheye ،یاصل ریهستند: تصو یشامل سه نوع اصل شینما یحالت ها

 .شود یسوار م واریبه عنوان مثال به د ریشوند. ز یاده مد شیورت متفاوت نماص

 .شوند یداده م شینما ریبه صورت ز یآ شیف ریشود، تصاو یانتخاب م یاصل ریکه تصو یهنگام

  

  

 توجه!     

  

      

 توجه!     
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 .شوند یداده م شینما ریبه صورت ز (dewarped) پراکنده یپانوراما ریشود، تصاو یانتخاب م کیکه پانورام یهنگام
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 fisheyeر یاز تصو (dewarped) پراکنده ریتصو کی( یدرجه ا 180 ریپانوراما )دو تصو ری، تصوانتخاب شود ی کف یا میزرو ای نصب سقفیاگر 

 .دیکن ، نصبینظارت یواقع یازهایمناسب مطابق با ن دید هیرا با زاو نیدرجه(. لطفا دورب 360 ریاست )تصو

 نیتقاطع ب هیکه زاو یشود زمان یداده م شیپانوراما نما ریتصو یف نصب شده باشد، هدف نظارت در قسمت بالادر سق نیعنوان مثال، اگر دورب به

 .درجه است 135ساعت  یکابل )آرم( دستگاه و هدف نظارت در جهت جهت عقربه ها یخروج

 

  

سمت چپ به راست، از بالا از  یمحل ریتصو 4شود،  یاز فهرست در سمت راست انتخاب م Panoramic + 4PTZ شینما شیکه حالت پ یهنگام

همانطور  د،یانجام ده یمحل ریهر تصو یرا بر رو PTZ کنترل و زوم اتیعمل دیتوان یشوند. شما م یداده م شینمابه صورت پیش فرض  نییبه پا

 .شده است دهنشان دا ریکه در شکل ز

 

  
 

 

 

 

 

 

 توجه!       
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 یو و دانلود ذخیره سازی جانبیپخش وید  5

 
 

به ضبط  یط محل( اشاره دارد. ضبنی)عمدتا دورب یدستگاه ظاهر کیکارت حافظه  در دئویبه ضبط و جانبی یساز رهیذخ نصب سقفیاگر  ⚫

 .اشاره دارد کاربر PC  کیبه  دئویو

 .شده است یربندکیپ یساز رهیذخنوع و کارت حافظه نصب شده  کیبا  نیکه دورب دیکن ی، بررسجانبی یساز رهیبا ذخ دئویاز پخش و قبل ⚫

 .دینیبب اتیجزئ یرا برا یواقع یشود. لطفا مدل ها ینم یبانیاز مدل ها پشت یعملکرد توسط بعض نیا ⚫

 

 پخش ویدیو 

 دیکن کیکل یصفحه اصل یرو Playback یبر رو .1

 

 

 

 

 

 

 

 

 

 

 

 

 

 .دیانتخاب کن میرا از تقو خیتار .2

 .دیکن کیکلQuery  یرو .3

 .پخش ویدیو برای موارد ضبط شده آغاز شودتا  دیکن کیکل دوبار روی دوره زمانی ، Results ریز در .4

 دانلود

 .دیکن کیکل یصفحه اصل یرو Playback یبر رو .1

  

 !توجه       
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 .شود ینشان داده م ستیل کیدر  جیوره مشخص شده. نتاد کیدر  ویدیو یجستجو برا .2

توان در  یرا م یمحل ریشما )مس یمحل ریمسظه به از کارت حاف ویدیو نی. ادیکن کیکل Download یو رو دیخود را انتخاب کن یویدیو .3

Local Settings شود یداد( دانلود م رییتغ. 

 .دیکن کیکل Open یشده است، رو ذخیره در آن ویدیکه و ینشان دادن پوشه ا یبرا .4

  PTZکنترل   6

 

 .نصب شده است افقی/  دیعموموتور  کی یاست که بر رو یا نعتیص نیدورب ای یگنبد PTZ یها نیدورب یعملکرد فقط برا نیا

 
 .هستند مناسب موتوردار مجهز به لنز یها نیدورب یاز توابع کنترل لنز برا یبعض •

 .دینیبب کند، رابط وب را یم یبانیپشتشما  نیکه دورب PTZ کنترل یدکمه ها یمتفاوت باشند. برا نیممکن است با مدل دورب PTZ کنترل یها دکمه •

  PTZنوار ابزار کنترل 

  شرح  مورد

Preset  

 شیپمکان از به  PTZ نی. دوربدیکن کیکل روی و سپس دیرا انتخاب کن شده میتنظ شیپمکان از  کی

 .ی انتخاب شده می رود شده میتنظ

  .دیکن کیکل  ی، روحذف  ی. برادیکن کیکل  یرو ، شده میتنظ شیپمکان از یک افزودن  یبرا

Patrol  

 .دیکن کیکل روی  یگشت زن یو سپس برا دینرا انتخاب ک یگشت زن ریمس کی

 .دیکن کیکل  یرو ،یگشت زن ریمس کی شیرایو یبرا •

 .دیکن کیکل  یرو ،یگشت زن ریمس کیاضافه کردن  یبرا •

  .دیکن کیکل  یرو ،یگشت زن ریمس کیحذف  یبرا •

  

 .دیکن میرا تنظ PTZ نیسرعت حرکت دورب

   

 .دیکن رهاکنترل را را کنترل کرده و  PTZ نیجهت دورب

  

  

  

  

  

 .IR خاموش کردن ایروشن 

 .دیخاموش کن ایرا روشن  برف پاک کن

 .دیخاموش کن ایرا روشن  گرمکن

 .دیکنخاموش  ای روشنپروژکتور را 

 .دیخاموش کن ایرا روشن زدایی برف 

  
/ 

/ 

/ 

/ 

/ 

 !توجه       
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  شرح  مورد

  
  وکوس دوربینتنظیم ف

  
 تنظیم زوم دوربین

  
 irisکاهش  ای شیافزا

 

  

دکمه  د،یده رییزنده تغ یشکلها در نما نیاز ا یکی یماوس را رو نکهیپس از ا .PTZ کنترل یبرا انبریم یدهایکل

 .کار کند PTZ نیتا دورب دیسمت چپ ماوس را فشار ده

 .کنند یم یبانیعملکرد را پشت نیا PTZ یها نیو دورب گنبدی PTZیها نیدورب فقط •

  .قابل استفاده هستند ریغ تالیجیزوم د ای عدیب3مکان یابی  تیگام استفاده از موقعدکمه ها هن نیا •

   

به  ای ییبزرگنما یبه جلو را برا اسکرول موسزنده.  شیدر نما ییکوچکنما ای ییبزرگنما یبرا انبریم یدهایکل

 .دیحرکت ده برای کوچک نماییعقب سمت 

  .کنند یم یبانیلکرد را پشتعم نیا موتورداربا لنز  ییها نیدورب فقط

  

 شده نییتع شیبا استفاده از نقاط از پ یگشت زن میتنظ

 فرض شیپ یمکان ها میتنظ

 اتیجزئ ی. برادیانجام ده PTZ نیدورب بارا  یکنترل خاص اتیعمل ای دیکن تیریرا مد شده میتنظ شیاز پ های مکان دیتوان ی، م  Presetدر برگه 

 .دیمراجعه کن PTZ نترلبه نوار ابزار ک شتر،یب

 افزودن یک مکان پیش فرض

 .دیکن کیکنترل پنل کل در  Preset ی، رو  Live Viewدر صفحه  .1

 

 .برسدبه سمت جهت دلخواه تا  دیکن میرا تنظ نیدورب .2

 .دیکن میتنظ ازینبا توجه به را  کوسوفمطلوب، زوم و  ریبه دست آوردن تصو یبرا .3

 .دیکن کیکل OK یو سپس رو دیوارد کن آن یشماره و نام برا کی دیکن کیکل تعیین شده روی  شیپز مکان اآن به عنوان  افزودن یبرا .4

  

1 

2 

3 

4 
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 دهرفتن به یک مکان از پیش تعیین ش

 .دیکن کیکنترل پنل کل در  Preset ی، رو  Live Viewدر صفحه  .1

 

 

 

 

 

 

 

 

 

 

 رد نظر می رود.مونقطه به  PTZ نی. دوربدیکن کیکل روی  یین شدهعیک مکان از پیش ت یبرا .2

 دهیک مکان از پیش تعیین ش کردن کپا

 .دیکن کیکنترل پنل کل در  Preset ی، رو  Live Viewدر صفحه  .1

 

 .دیکن دییو سپس حذف را تا. دیکن کیکل روی  یین شدهعیک مکان از پیش ت یبرا .2

 یگشت زن میتنظ
 کیکه  یکند. طول زمان یاستفاده م یبه بعد یین شدهعن از پیش تمکا کیهنگام حرکت از  PTZ نیدورب کیاست که  یریمس زنی گشت ریمس

 .مجاز است PTZ نیدورب کی یچندگانه برا یگشتزن یرهایاست. مس میماند قابل تنظ یم یباق یین شدهعمکان از پیش تدر هر  PTZ نیدورب

  

      

1 2 

  

      

1 2 
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است. شما  یاز زمان قبل از رفتن به بعد یمقدار مشخص کی یبرا آنجادر  ماندنو  یین شدهعمکان از پیش ت کیشامل رفتن به  یاقدامات گشت زن

به  اکند و آن ر یرا ثبت م حرکت ریمس ستمی. سدیکن میتنظرا و زمان ماندن  یجهت چرخش، زوم، سرعت چرخش، زمان گشت زن دیتوان یم

طور مکرر دنبال و گشت را به  ریهمان مس PTZ نیتا دورب دیرا انتخاب کن   Keep Rotating دیتوان یکند. شما م یاضافه م عملیات ها ستیل

 .کند

 نیافزودن یک مسیر گشت ز

 .دیکن کیکنترل پنل کل در  Patrol ی، رو  Live Viewدر صفحه  .1

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 کلیک کنید.  روی  .2

. تا دیکن کیکل  Add ی، روزنی اقدام گشت کیاضافه کردن  یسپس برا د،یو نام را وارد کن ری، شناسه مسAdd Patrol  در صفحه .3

 32 نیابراشده است، بن میتنظ Zoom و Move Direction یکه نوع عمل برا ،یعمل مجاز است. هر خط شامل دو عمل زمان 64

 .دیاز اقدامات استفاده کن یا لهدنبا میتنظ یعمل مجاز است. از دکمه ها برا

 :عبارتند از زنی گشت اقدامات

  یاز زمان قبل از رفتن به بعد یمقدار مشخص کی یبرا آنجادر  دنمانو  یین شدهعمکان از پیش ت کیرفتن به  •

 یمدت زمان مشخصماندن برای از زمان، زوم،  یمقدار مشخص کی یشده برا نییشده در جهت تع نییدر سرعت تع چرخش •

 .انتخاب شده باشد Keep Rotating بطور مکرر اگر یگشت زن ایشده  میتنظ تیدر موقع

 .باشد Go to Preset وع عملن نیشود اول یم هیتوص

 دیکن کیکل OK یرو .4

 

 ضبط کردن یک مسیر گشت زنی

 .دیکن کیکنترل پنل کل در  Patrol ی، رو  Live Viewدر صفحه  .1
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 ستمیس نیا. دیکن میرا تنظ نیجهت و زوم دورب طول ضبط در دیتوان ی. شما مدیکن کیکل روی ، زنی گشت ریشروع ضبط مس یبرا .2

 .کند یاضافه م ها فعالیتت لیسکند و آنها را به  یم یابیردرا  نیدوربو  را ضبط کرده رکتح

 

 یشود. شما م یم رهیذخ ریمس حالت کیبه طور خودکار به عنوان  زنی گشت ری. سپس مسدیکن کیکل  یضبط، رو لیتکم یبرا .3

 .کلیک کنید  روی ریمس حالتحذف  یبرا ایو  دیکن کیکل روی  زنی شروع گشت یبرا دیتوان

  

  

  

    

2 



1 
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 ساخت برنامه زمانی برای گشت زنی
 .دیکن کیکنترل پنل کل در  Patrol ی، رو  Live Viewدر صفحه  .1

 
 .دیرا انتخاب کن Enable Patrol Plan نهیگز .4

 .دیکن کیکل OK یرو .5

 گشت زنی  مسیر شروع

 .دیاب کنانتخ زنی آغاز گشت یرا برا یگشت زن ریمس ،زنی گشت ریمس کیپس از افزودن 

 .دیکن کیکنترل پنل کل در  Patrol ی، رو  Live Viewدر صفحه  .1

 

 ت زنیویرایش یک مسیر گش

 .دیکن کیکنترل پنل کل در  Patrol ی، رو  Live Viewدر صفحه  .1

  

 .شود یداده م شینمازنی گشت  زمانیبرنامه  میتنظ یبرا ای صفحه دیکن کیکل وی ر     . 2  

 .دیکن میدرست را تنظ ریو مس زنی زمان گشت    . 3

  

  

2 

  
    

 .دیکن کیکل روی  دیشروع کن دیخواه یکه م ای یگشت زن ریمس یبرا.   2

  

1 
2 



1 
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 ک مسیر گشت زنیپاک کردن ی

 .دیکن کیکنترل پنل کل در  Patrol ی، رو  Live Viewدر صفحه  .1

 

 حتتنظیم موقعیت استرا
 .شود یبازگردانده م خانه(استراحت) تیبه وضع PTZ نیانجام نشود، دورب یاتیعمل چیه نیمع زمانی دوره کیاگر در 

 
 .شبکه در دسترس استتحت  PTZ یها نیدورب یتنها برا عملکرد نیا ⚫

 . دیرا اضافه کن زنی گشت ریمس کی ایشده  میتنظ شیاز پ مکانهای دیابتدا با شما ⚫

 

  

شوید . Setup > PTZ > Home Position وارد  .1

  

      
 .دیده رییرا در صورت لزوم تغ ماتیو تنظ دیکن شیرایو دیخواه یکه مای  یگشت زن ریمس وکلیک کنید  روی .2

 
  

2 

  

    
 .دیکن دییو سپس حذف را تا دیکن کیکلروی   دیحذف کن دیخواه یکه م یگشت زن ریمس یبرا.   2

 
  

1 
2 

 !توجه       
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 .دیحالت و شناسه را انتخاب کنیک  .2

 دیکن کیکل Save یرو .3

 PTZ نترل از راه دورک

 یعملکرد کنترل از راه دور را برا دیتوان یم ست،یبا آن منطبق ن PTZ و پروتکل ردیگ یکه پلت فرم شخص ثالث مورد استفاده قرار م یهنگام

 .دیکن میتنظ PTZ کنترل

 
 شود. یم یبانیپشت PTZ یها نیتنها توسط دورب عملکرد نیا ⚫

 
  

1. Setup > PTZ > Remote Control . را انتخاب کنید 

  

مهم  یپارامترها یبرخ ری. جدول زدیکن میو کد آدرس را تنظ listener . پورتدیرا انتخاب کن  Remote Control  ،Onفعال کردن  یبرا .2

 .دهد یرا شرح م

  شرح  عنوان

Listener Port  
فرض را فقط در صورت  شیپ ماتی. تنظباشداستفاده حال پورت  کی تواندیکه نم ن،یدورب یپورت محل

 .دیده رییلزوم تغ

Address Code  
که کد آدرس در  یزمان فقط نیتواند کد آدرس موجود در دستورالعمل را بخواند. دورب یم نیدورب

 .کند یم ریدستورالعمل را تفس ده استش میتنظ نجایاست که در ای دستورالعمل، کد

  

 .دیکن کیکل save یرو .3

  PTZمحدودیت 

 .کند یریجلوگ واریموانع مانند داصابت به از  PTZ نیتا دورب دیکن میچرخش را تنظ تیمحدود

 
 شود. یم یبانیپشت PTZ یها نیدورببعضی تنها توسط  عملکرد نیا ⚫

 
 شوید .Setup > PTZ > PTZ Limit   وارد .1

  

  

 !توجه     

 !توجه     
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 .مورد نظر تیبه موقع نیچرخاندن دورب یجهت دار برا یاستفاده از دکمه ها .2

 میتنظ ییتا حد بالا دیکن کیکلروی صفحه  یمثال، در بالا ی. برادیکن کیکل ت روی یبه عنوان محدود یفعل تیموقع میتنظ یبرا .3

 .شود

 .میچرخاند یلفع تیرا به موقع نی، دوربروی  کردن کیبا کل د،یده رییجهت را تغ اگر

 .دیچپ، راست( تکرار کن ن،یی)بالا، پا ازیها به صورت مورد ن تیتمام محدود صیتخص یفوق را برا یگام ها .4

 .دیکن کیکل Save یرو .5

 .اعمال شود ماتیتا تنظ دیکن کیکل  Start PTZ Limit یرو .6

 .دیکن میرا مجددا تنظ تیو محدود دیکن کیکل روی  ماتیحذف تنظ یبرا .7

 ادامه گشت زنی

 شوید . Setup > PTZ > Patrol وارد  .1

  

 .دیکن میرا تنظکند  یمادامه پیدا  یکه گشت زن یزمان .2

 .دیکن کیکل Save یرو .3

  

      

              

      

1 

2 

3 

4 
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 واژه نامه A پیوست
 

Acronym  Description   

ARP  Address Resolution Protocol  

CBR  Constant Bit Rate  

DNS  Domain Name Service  

DDNS  Dynamic Domain Name Service  

DHCP  Dynamic Host Configuration Protocol  

DST  Daylight Saving Time  

FTP  File Transfer Protocol  

GOP  Group Of Pictures  

GUI  Graphical User Interface  

HTTPS  Hyper Text Transfer Protocol over SSL  

IE  Internet Explorer  

IMOS  IP Multimedia Operation System  

IP  Internet Protocol  

IPC  IP Camera  

MTU  Maximum Transmission Unit  

NTP  Network Time Protocol   

OSD  On Screen Display  

PoE  Power over Ethernet  

PPPoE  Point-to-Point Protocol over Ethernet  

PTZ  Pan, Tilt, Zoom  

ROI  Region of Interest  

SMTP  Simple Mail Transfer Protocol  

SSL  Secure Socket Layer  

UNP  Universal Network Passport  

USB  Universal Serial Bus  

VBR  Variable Bit Rate  

WDR  Wide Dynamic Range  
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 پرسش و پاسخ B وستیپ

 

  چه کاری باید انجام دهم ؟ بار نیاول یبرا 7 ندوزیو در ستمیس هنگام ورود به  ActiveXنصب  یمن برا به امیدر صورت عدم ارسال پ

 :دیو سپس دوباره وارد شوهای زیر را انجام داده گام  UAC خاموش کردن ی: براپاسخ

 .دیکن کیکل Control Panel یو سپس رو دیکن کیکل Start دکمه یرو. 1

 .دیکن کیکل Change User Account Control Settings یو سپس رو دیکن پیرا تا  uacدر کادر جستجو، . 2

 .دیکن کیکل OK یو سپس رو دیده انتقال  Never Notifyرا به  متحرکنوار . 3

 .دی، دوباره وارد شوUAC پس از خاموش کردن. 4

  

 انجام شود ناموفق ActiveX اگر نصب دیانجام ده دیبا یکار چه

اکسپلورر باز  نترنتیرا در ا Internet Option نهی: گزدیمعتبر اضافه کن تیسا کیرا به عنوان  نیدورب IP ، آدرسباشد ناموفق: اگر نصب جواب

 .دیرا اضافه کن تیتا وب سا دیکن کیکل  Sites یسپس رو د،یکن کیکل Trusted sites یرو د،یکن کیکل  Securityزبانه  یرو د،یکن

 Run as د،یراست کن کیکل لیفا یرو د،یکن رهیخود ذخ وتریکامپ ردرا  setup.exe دیابتدا با د،یکن یاستفاده م 7 ندوزیاز و اگر

administrator  دیو سپس آن را با توجه به دستورالعمل نصب کن دیرا انتخاب کن. 

  

 د؟یکن ی، چه کار مپخش نشود ویدیاگر و د،یشویم نمایش زندهبار وارد  نیاول یبرا ستمیورود به س در یوقت

 .دیو سپس دوباره به رابط وب وارد شو خود را بسته  وتریکامپ روالیفا: پاسخ

 

 

  


